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About this manual
This manual is intended to get you started with using ER Mapper to create mo
of digital aerial photographs. It provides simple step-by-step procedures that g
you hands-on practice using advanced features of the software.

This manual is not intended to cover all ER Mapper functionality, and does no
cover concepts of digital photogrammetry such as DEM generation. Please re
the ER Mapper Tutorial and User Guide manuals for more detailed information a
needed. (These are also accessible directly from the on-line help system.)

Chapter contents
The chapters in this manual give you extensive hands-on experience using th
ER Mapper software through a series of specially designed lessons.  Most les
have two basic sections: 

• an overview of key concepts

• a series of step-by-step hands-on exercises

It is recommended that you start at the beginning and proceed through the ch
in order because the later chapters build on concepts learned in earlier ones.

The emphasis of this manual is on learning and using the ER Mapper software
on teaching image processing, airphoto interpretation, and other concepts. 

Setting up practice datasets
The exercises in this manual assume that ER Mapper 6 is installed and licens
and that the example airphoto datasets have been installed in the 
‘examples\functions_and_features\airphoto_tutorial’ directory. 
ER Mapper Airphoto Mosaic Tutorial 11
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Typographical conventions 
The following typographical conventions are used throughout this document: 

• ER Mapper menus, button names and dialog box names are printed in boldfa
Helvetica type, for example: 

“Select Print  from the File  menu to open the Print  dialog box.”

• Where you are asked to click the mouse on an icon button in the user interface
the button and its formal name are indicated in the text. For example:

“Click on the Edit Transform limits  button.”

• Text to be typed in a dialog box text field is shown in boldface Courier typeface
example: 

“Type RGB_airphoto_mosaic in the text field.” 
12 ER Mapper Airphoto Mosaic Tutorial
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Airphoto mosaics
and ER Mapper

This chapter provides an overview of airphoto concepts and steps used for cre
mosaics of digital airphotos. It also describes the basics of image processing 
use of the ER Mapper software in assembling airphoto mosaics.

Overview of airphotos and applications
Aerial photographs are taken from an aircraft to capture a series of images us
large roll of special photographic film. The film is then processed and cut into 
negatives. The most common size for negatives is 9" x 9" (23cm x 23cm). The
scale of the aerial photograph depends on the height of the aircraft when the 
was taken. Aerial photographs are taken with an overlap between each one, t
ensure that a final mosaic can be assembled. 

Airphotos are now being used extensively as basemaps for updating vector da
is stored and manipulated in GIS and DMS systems. Often it is necessary to c
a mosaic of several airphotos to cover the desired area. Common uses and m
applications for airphotos include:

• land use/land cover mapping

• urban and regional planning

• environmental assessment
ER Mapper Airphoto Mosaic Tutorial 13
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• civil engineering

• geologic and soil mapping

• agricultural and forestry applications

• water resource and wetland applications

Types of airphotos
There are generally four types of airphotos in common use, and these are crea
using specific types of film in the camera:

• Panchromatic–often called black and white, is sensitive to the same range of l
wavelengths as perceived by the human eye (the “visible” wavelengths blue, g
and red spanning 0.4 to 0.7 micrometers). Panchromatic photos are most com
used for planimetric and/or topographic mapping. Digitized black and white ph
have a single band (layer of information), so they are usually displayed in grey
on a computer.

• Natural color–often called true color, is also sensitive to the same wavelength
light as perceived by the human eye. Digitized natural color photos have three
separate bands, one each for the blue (0.4-0.5 micrometers), green (0.5-0.6) a
(0.6-0.7) wavelengths of light. They are usually displayed using the RGB colo
system on a computer to recreate the same colors as on the photo print. Natu
photos are commonly used for creating photo maps, or for mapping application
require discrimination of the color of features.

• Infrared –often shortened to “IR,” is sensitive to a range of wavelengths that 
includes the red, green and near infrared portions of the spectrum. The near in
wavelengths (0.7-1.0) cannot be perceived by the human eye, so they provide
information that beyond the human perception system. Like panchromatic, digi
IR images have a single band and are usually displayed in greyscale.

• Color infrared –often called false color or shortened to “CIR,” was developed 
during World War II to aid camouflage detection. Digitized CIR images have th
separate bands, one each for the green (0.5-0.6), red (0.6-0.7) and near infrare
1.0) wavelengths of light. Like natural color, they are usually displayed using t
RGB color system to recreate the same colors as on the photo print. Vegetati
usually appears red on these images, thus the term false color. CIR photos ar
commonly used for agricultural, forestry and wetland studies because the IR b
provides valuable information on vegetation health, species and biomass.
14 ER Mapper Airphoto Mosaic Tutorial
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Digitizing (scanning) of airphotos
In order for an aerial photograph to be processed in a computer, the photo mus
be scanned or digitized to create a digital image file. The photo print or 
transparency is run through a scanner to convert visible images to digital files
Many airphoto acquisition firms supply their photo data already converted to dig
image format, but you may also want or need to scan the photos yourself.

Note: Aerial photographs normally have fiduial marks around the edges. The positio
these marks are crucial for orthorectification. It is, therefore, essential that the
scanner that use is alrge enough to include the fiducial marks in the scanned 

Two factors affect the resolution, or size of features that can be detected, in th
digital image of the aerial photograph. These factors are: 

• The scale at which the aerial photograph was flown. This is based on aircraft alt
above ground and focal length of the camera during photo acquisition. 

• The Dots Per Inch (DPI) used to scan the aerial photo. This determines the si
the ground, in meters or feet, of one pixel on the digital aerial photograph, and
approximately corresponds to the size of the smallest feature that can be dete

Use the following table to decide what scale aerial photography to use and wh
DPI resolution to use when scanning the photos.  A pixel size of 1 meter is 
adequate for many applications.
ER Mapper Airphoto Mosaic Tutorial 15
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Ask your aerial photograph supplier if they can provide you the aerial photogra
pre-scanned, on a CD-ROM, in a format supported by ER Mapper. This will sa
you having to scan the photos yourself.

Image formats supported by ER Mapper include:

• ER Mapper Algorithm (.alg)

• ER Mapper Raster Dataset (ers)

• ER Mapper Compressed Image (.ecw)

• Windows Bitmap (.bmp)

• ESRI BIL and GeoSPOT (.hdr)

• GeoTIFF/TIFF (.tif)

• 1 bit tiled tiff

• 1bit strip tiff (compressed and uncompressed)

• 1bit scanline tiff (compressed and uncompressed)

• 8 bit greyscale tiled tiff

• 8 bit RGB contiguous tiled tiff

• 8 bit RGB separate tiled tiff

• JPEG (.jpg)

• USGS DOQQ (Grayscale)

• RESTEC/NASDA CEOS (.dat)

Digital Orthophoto Quadrangles
Airphoto images can be supplied as Digital Orthophoto Quarter Quadrangles,
known as DOQQs.

Photo scale: 10000 24000 40000

Km. across: 2.3 5.5 9.1

Pixel size in meters # of pixels color B & W

150 dpi scan 1.7 4.1 6.8 1350 5 Mb 2 Mb

300 dpi scan 0.8 2.0 3.4 2700 21 Mb 7 Mb

600 dpi scan 0.4 1.0 1.7 5400 83 Mb 28 Mb

1200 dpi scan 0.2 0.5 0.8 10800 334 Mb 111 Mb

2400 dpi scan 0.1 0.3 0.4 21600 1335 Mb 445 Mb

Scanned image file sizes:

:

16 ER Mapper Airphoto Mosaic Tutorial
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A digital orthophoto is a digital image of an aerial photograph in which 
displacements caused by the camera and the terrain have already been remo
Therefore it combines the image characteristics of a photograph with the geom
qualities of a map. A DOQ image typically covers one-quarter of a 1:24,000 sc
USGS topographic map plus a little overlap. The resolution of the image is qu
high at one square meter per pixel. As a result of this fine cell size, these imag
consume large quantities of disk space. A DOQQ is a subset of a DOQ, in tha
refers to a Digital Orthophoto Quarter Quad. There are four DOQQs in a DOQ

You can open DOQQ images directly in ER Mapper, and then use ER Mapper
wizards to mosaic and balance them. 

Creating airphoto mosaics
An airphoto mosaic is an assemblage of two or more overlapping photographs 
form a composite view of the area covered by the individual photos. Typically 
aircraft flies back and forth across an area acquiring a set of photos that over
then the photos are scanned, rectified and assembled into a mosaic.

Aircraft flight
while taking aerial
photographs

Photo
#1

Photo
#2

Photo
#4

Photo
#5

Photo
#6
ER Mapper Airphoto Mosaic Tutorial 17
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The basic steps involved in creating a mosaic of airphotos are shown below. T
steps are covered in detail in the exercises in this workbook.

Digitize

Read/Import

Initial

Image

Scan (digitize) airphoto hardcopy prints or transparencies

airphotos

digital 

image display
& evaluation

rectification

Create

Annotation

Data saving

mosaic
of images

& map
composition

and/or
compression

to create digital image files, or acquire digital format
photos saved in image formats such as TIFF.

Assemble rectified, enhanced images into a mosaic.

Setup map size/scale, and annotate mosaic of images

Save the processed mosaic in a format suitable for use

with text, lines, shaded polygons, legends, scale
bars, coordinate grids and other map objects.

airphotos

Read digital airphoto image files stored on tape,
CD-ROM, etc. into ER Mapper. If necessary, 

format 

View image data on to evaluate
quality or area coverage, or display statistical
information such as histograms or cell values.

Geometrically correct (rectify or geocode) images to 
correspond to geodetic coordinate systems and map
projections such as UTM, State Plane, etc.

convert to ER Mapper image
(using ER Mapper import utilities)

in GIS and DMS applications, or for serving from an 
Image Web Server.

Balance
mosaic

of images

Balance contrast across the mosaic, and minimize
visible seam lines between adjacent images.
18 ER Mapper Airphoto Mosaic Tutorial



Chapter 1 Airphoto mosaics and ER Mapper ● Creating airphoto mosaics

ou 
pe, 
ork. 

s), 

rmat

ng 
 

QQ. 
e 
 these 

e 
e of 
ality, 
r 

 or a 

of a 

de” 
ic 
M.

 
 
iew 

s. 
Data load/import
The first step in creating an airphoto mosaic is loading or importing the data y
want to use into ER Mapper. Typically the data might be stored on magnetic ta
CD-ROM, or be available for download from an Image Web Server over a netw

When you import a raster image file (using ER Mapper’s import utility program
ER Mapper converts the data and creates two files:

• a binary data file containing the image data, in band interleaved by line (BIL) fo

• a corresponding ASCII header file with an “.ers” file extension

You can open image files in many different formats in ER Mapper without havi
to import them as ER Mapper raster datasets. Some of these formats contain
embedded georeferencing information, which ER Mapper uses to mosaic the 
images. These formats include ECW V2 compressed, GeoTIFF and USGS DO
Some TIFF images have an accompanying ‘World’ file, TIFW, that contains th
georeferencing information. ER Mapper creates a separate .ers header file for
to accommodate statistical information used for balancing.

Image display
After loading or importing the image data, the next step is usually to display th
image to evaluate the data quality, geographic area of coverage, and coverag
overlapping areas with other images used in a mosaic. If the data is of poor qu
you might decide to digitize the photos again. If it has significant cloud cover o
haze over your area of interest, you might try to obtain better data.

There are two primary ways airphotos are viewed: 

• black and white, or greyscale displays (used to view black and white airphotos
single band of a color airphoto)

• red-green-blue (RGB) color composite displays (used to view all three bands 
color or color IR airphoto to reproduce the look of the original print)

The way in which you choose to display your raster data is called the “Color Mo
in ER Mapper. You can also view data in traditional two-dimensional planimetr
views, or 3-D perspective views if you have an elevation dataset such as a DT

In addition to displaying the data, you may want to view statistical information
about it. Statistics are often good indicators of image quality. You may want to
calculate statistics for the image, such as the mean value in each band, and v
them in a tabular format. Or you may want to view statistical information in a 
graphical format using tools like histograms, scattergrams, and traverse profile
ER Mapper Airphoto Mosaic Tutorial 19
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Image geocoding
Raster image data is often supplied in a “raw” state and contains geometric er
Whenever accurate area, direction, and distance measurements are required
image data must usually be processed to remove geometric errors and/or rect
image to a real world coordinate system.

• Registration is the process of geometrically aligning two or more images to allo
them to be superimposed or overlaid.

• Rectification is the process of geometrically correcting raster images so they 
correspond to real world map projections and coordinate systems (such as La
Longitude or Eastings/Northings).

• Orthorectification is a more accurate form of rectification mainly used on airphot
It takes into account properties of the camera used to take the images, fiducial 
on the image and terrain details.

If your application requires that your images be registered to one another or 
rectified to a map projection, you can use ER Mapper’s Geocoding Wizard to 
this.

Note: DOQQ images have already been orthorectified, so you do not need to use 
ER Mapper to do it again.

Note: The Geocoding Wizard only supports the ER Mapper Raster Dataset format. 
Images in any other format that require geocoding will have to be saved as 
ER Mapper Raster Datasets first. This includes ECW compressed images.

Creating image mosaics
A mosaic is an assemblage of two or more overlapping images used to create
continuous representation of the area covered by the images. ER Mapper auto
the building of image mosaics because co-registered images referenced in the
processing algorithm are automatically displayed in their correct geographic 
positions relative to each other. 

This means that you are not required to write all images to one large file on di
order to process and enhance them. This capability is especially important wh
working with large image files such as scanned airphotos, because final mosa
can consume gigabytes of disk space if they would have to be saved in a sing

The ER Mapper Image Display and Mosaic Wizard  automatically mosaics 
images in a specified directory path.
20 ER Mapper Airphoto Mosaic Tutorial
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Image enhancement and correction
Image enhancement refers to any one of many types of image processing 
operations used to digitally process image data to aid visual interpretation, ex
quantitative information, or correct color/brightness distortions. Image 
enhancement is what many people commonly think of as “image processing.”

In ER Mapper, image enhancement operations are greatly simplified by the 
“algorithms” processing concept. Nearly all types of image enhancement 
operations can be applied and displayed in real time to provide truly interactiv
control without writing temporary files to disk. 

Typical image enhancement operations include:

• Contrast enhancements–Improve image presentation by maximizing the contras
between light and dark portions (or high and low data values) in an image. Or
highlight a specific data range or spatial area in an image.

• Color balancing–Use the ER Mapper Color Balancing Wizard  to balance 
mosaiced images to produce a seamless single image.

Data saving and compression
Once you have completed processing your data, ER Mapper lets you save yo
image in a format suitable for serving, for use or further processing.

• ECW Compression enables you to save your imagery in compressed format fo
in other applications or serving from an Image Web Server.

• Data export is used to export all or part of a processed airphoto mosaic for us
other software products, such as a backdrop for a GIS or DMS (desktop mapp
system) product. Or, you may want export vector annotation or vectorized them
data to a GIS product. 

• Free plug-ins enable you to open ER Mapper images, including ECW compre
images, from within many GIS products.

• Hardcopy printing is often the final goal of processing and annotating images,
ER Mapper provides hardcopy support and output to standard graphics file form
ER Mapper also includes a built-in PostScript-compatible rendering engine, so
get PostScript-quality output (such as beautiful, smooth text) on any supporte
device, whether the device supports PostScript or not. 

You can also easily print at exact sizes and map scales, and automatically pri
large images in strips for assembling a mosaic of prints. Supported hardcopy 
devices include inkjet printers, laser printers, dye sublimation printers, electros
plotters, and film recorders. Graphics file formats include PostScript, TIFF, Ta
CGM, and CMYK and RGB color separations.
ER Mapper Airphoto Mosaic Tutorial 21
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Map composition
ER Mapper’s Map Composition tools let you create top quality image maps by
adding coordinate grids, map collars, scale bars, legends, north arrows, and m
other map objects and standard cartographic symbols. You can layout and com
maps comprised of multiple processed images, and size and scale map outpu
desired. All map objects are defined as full color PostScript, and you can easil
custom map objects such as company logos or special north arrows.

Image processing concepts
The term digital image processing refers to the use of a computer to manipulate 
image data stored in a digital format. The goal of image processing for earth 
science applications is to enhance geographic data to make it more meaningf
the user, extract quantitative information, and solve problems.

A digital image is stored as a two-dimensional array (or grid) of small areas ca
pixels (picture elements), and each pixel corresponds spatially to an area on t
earth’s surface. This array or grid structure is also called a raster, so image data is 
often referred to as raster data. The raster data is arranged in horizontal rows call
lines, and vertical columns called samples. Each pixel in the image raster is 
represented by a digital number (or DN). 

rows
(lines)

columns
(samples)

raster image displayed as grey levels
(lower values displayed as dark greys)

enlarged view showing individual cells
or pixels and their corresponding DNs

61

110 81 57

87

69 44

42

31
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For digitized airphotos, the DNs represent the intensity of reflected light in the
visible, infrared, or other wavelengths of the electro-magnetic spectrum. By 
applying mathematical transformations to the digital numbers, ER Mapper can
enhance image data to highlight and extract very subtle information that would
impossible using traditional manual interpretation techniques. 

Black and white airphotos capture reflectance of ground features in a single ra
of wavelengths, for example visible red/green or infrared (IR). Color airphotos
have three bands (or layers) of data covering the same geographic area, each 
capturing reflectance of a different wavelength of light. A natural color airphoto
for example, has three bands of data that record reflectance from the earth’s s
in the red, green and blue wavelengths of light respectively.

ER Mapper image processing
ER Mapper lets you combine many processing operations into a single step, a
render the results directly to your screen display in near real-time. (In most ca
no processed copies of your original data are written to disk unless you reque
do so.) The set of processing steps you apply to your data is called an “algori
in ER Mapper. 

With ER Mapper, you need to save only a description of the processing steps you 
wish to apply to the data (the algorithm), not separate processed copies of the 
original raster data file. By storing the processing steps separately from the ac
data, image processing becomes faster, easier to learn, and more interactive.

In ER Mapper, algorithms can be used for simple viewing of data such as grey
or RGB band combinations. Algorithms are also used for complex processing
modelling operations involving many images, transformations of the data, and
overlays of vector data–in both 2-D planimetric and 3-D perspective views. 

The algorithms design also allows ER Mapper to easily handle very large airp
images (and mosaics of images) much more efficiently than traditional system
Reducing the need to write processed copies of the data to disk is a very imp
consideration.

Processing algorithm:
   - formulas (corrections, etc.)

Input file    - filters (sharpen, edges,)
   - contrast & brightness
   - seam feathering, etc...

Image
display
ER Mapper Airphoto Mosaic Tutorial 23
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Opening and
viewing an

image
This chapter shows you how to open a digitized airphoto in TIFF format, and h
to display it as a color image and enhance the contrast. You learn about the 
interface ER Mapper provides for creating and editing data view algorithms (th
Algorithm  dialog).

About the algorithms concept
The goal of all image processing is to enhance your data to make it more 
meaningful and help you extract the type of information that interests you. To m
this procedure faster and easier, Earth Resource Mapping developed a new im
processing technique called “algorithm data views.” Understanding how to use
algorithms is the key to understanding how to use ER Mapper effectively. 
ER Mapper Airphoto Mosaic Tutorial 25
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What is an algorithm data view?
An algorithm is a list of processing steps or instructions ER Mapper uses to 
transform raw datasets on disk into a final, enhanced image on your screen di
In this sense, algorithms let you define a “view” into your data that you can sa
reload, and modify at any time.

You use ER Mapper’s graphical user interface to define your list of processing
steps, and you can save the steps in an algorithm file on disk. An algorithm file
store any of the following information about your processing:

• Names of image dataset(s) to be processed and displayed

• Subsets of the dataset(s) to be processed (zoomed areas)

• Bands (layers of data) in the dataset(s) to be processed

• Color mapping and contrast enhancements (Transforms)

• Filtering to be applied to the data (Filters)

• Equations and combinations of bands or datasets used to create the image 
(Formulae)

• Color mode used to display the data (Pseudocolor, Red Green Blue, or Hue 
Saturation Intensity)

• Any vector datasets, thematic color, or map composition layers to be displayed
the raster image data

• Definition of a page size and margins (used for positioning the image on a pag
creating maps and printing)

• Viewpoint and other parameters when viewing the image in 3D perspective

By being able to apply a set of processing steps as a single entity, the comple
often associated with image processing is greatly simplified. In addition, you g
tremendous savings in disk space, since you do not need to store intermediat
processed copies of your original data on disk.

Building Algorithms in ER Mapper
There are three primary ways to build a processing algorithm in ER Mapper:

• Open an image dataset directly (Open ) and have ER Mapper automatically displa
the image using a simple default algorithm

• Use the Algorithm  dialog options to build an algorithm by adding the desired typ
of layers, loading datasets, and specify processing steps for each layer.

• Use image wizards to have ER Mapper automatically create any of several typ
specialized algorithms for you. In this case, ER Mapper adds the appropriate l
to the Algorithm  dialog, prompts you to load a dataset, and possibly other opti
as well.
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The Algorithm dialog
The Algorithm  dialog is a special dialog box that serves as your “command 
center” for creating and editing algorithms in ER Mapper. To open the Algorithm  
dialog, you can select Algorithm...  from the View  menu or click the Edit 

Algorithm   toolbar button. The key components of the Algorithm  dialog are 

labelled below and described in the table that follows.

Data structure diagram Shows a list of surfaces and layers contained in the 
current algorithm using a hierarchy or “tree” structure.
Select (click on) a surface or layer change its options 
using the Tab pages.

Surface A group of raster and/or vector data layers that combi
to create a view or image. A single algorithm can have
multiple surfaces that become independent entities wh
viewed in 3D mode.

Layers Components of a surface that contain data used to 
construct an image. Different layer types can contain 
raster or vector data, and processing for each layer is
controlled independently from the others.

View Mode Sets the manner in which data is displayed as two 
dimensions (2D) normal or page layout, or three 
dimensions (3D).

process diagram
for selected
layer

menu to add
or change
layers/surfaces

tab pages to select categories of options for
layer or surface (Layer tab page is selected)

data
structure
diagram

list of layers
in surface

view mode (2D or 3D)

surface

panel
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Tab pages Display categories of options for controlling the image
display and processing techniques, such as Layer for
options for the current layer, or Surface for options tha
apply to an entire surface.

Process diagram Used to control the processing operations applied to 
image(s) in the currently selected layer (displayed wh
Layer tab is selected).

The Process Diagram
When the Layer tab is selected, the horizontal row of buttons on the right-lowe
panel of the Algorithm  dialog are called the process diagram. They are used to 
define your image enhancement and processing operations for the currently 
selected data layer. Each button in the diagram controls a specific image proce
function.

As the arrows indicate, the processing stream flows from left to right. Typically
you may specify a dataset to be used, the bands within the dataset to be proc
then apply processing using formulae, filters, transforms or other options to cr
your desired image. ER Mapper compiles all the processing steps you specifie
renders the resulting image to the screen display. The name and function of th
main processing diagram buttons are as follows.

Button Function

Load Dataset Use to load an image dataset from disk, or edit or 
view information or comments about an image. 

Band Selection Use to select one or more bands in the dataset for use 
in generating an image (a drop-down list). 

Formula Use to enter, load, or save a formula to perform image 
algebra and other arithmetic operations. 

Filter Use to add or delete one or more spatial filters. (There 
are both pre- and post-formula Filter buttons.) 

Transform Use to adjust image contrast and brightness. (There 
are both pre- and post-formula Transform buttons.) 

Sun Angle Use to specify sun angle illumination of the image to 
create shaded relief effects. 
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Note: A cross or “X” through the button indicates that the function is not active in the
current data layer. In addition, there are other buttons for some layer types tha
will learn about later in this manual.

Hands-on exercises
These exercises show you how to open a digitized airphoto in ER Mapper, dis
enhance the image, and then save and reload a simple image processing alg

• Load and display an image dataset

• Use transforms to adjust the image contrast

• Add text labels and comments to an algorithm

• Save the processing algorithm to disk

• Reload and view the saved algorithm

1: Displaying an airphoto image 

Note: The sample airphoto tutorial datasets must be installed on your computer befo
you can complete this exercise. 

About loading data
You can open any of the following image data formats directly into ER Mapper
without having to import them as ER Mapper Raster Datasets:

• ER Mapper Algorithm (.alg)

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to open an image window and the Algorithm  dialog, load an image, and 
display the image in color. 
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• ER Mapper Raster Dataset (ers)

• ER Mapper Compressed Image (.ecw)

• Vector Map (.erv)

• Windows Bitmap (.bmp)

• ESRI BIL and GeoSPOT (.hdr)

• GeoTIFF/TIFF (.tif)

• JPEG (.jpg)

• USGS DOQQ (Grayscale)

• RESTEC/NASDA CEOS (.dat)

In this example you will open an image in TIFF format.

Open an image window and the Algorithm dialog
1 From the View  menu, select Algorithm... .

A new empty image window opens in the upper-left corner of the screen, and 
Algorithm  dialog opens.

Note that the Algorithm  dialog shows a default surface with one Pseudocolor 
layer in the left-hand panel (labelled “Pseudo Layer”), and a process diagram
that layer in the right-hand panel. The words “No Dataset” above the process 
diagram indicate that no dataset is currently loaded into the layer.

Note: If you open the Algorithm  dialog when no image windows are currently open (
in this case), ER Mapper opens an empty image window for you automatically
This shortcut saves you the step of opening a window. 

Load the airphoto dataset into the Pseudo Layer

1 In the Algorithm  dialog, click the Load Dataset   button..

Load Dataset  button
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The Raster Dataset  file chooser dialog box appears.

2 From the Directories  menu (on the Input File dialog), select the path 
ending with \examples . 

3 Double-click on the directory named ‘functions_and_features’ and then 
‘airphoto_tutorial’ to open it.

4 Double-click on the image file named ‘1_3_rect.tif’ to load it.

ER Mapper will display only the red band of the color airphoto in a pseudocolo
layer. 

5 View the red, green and blue bands individually by selecting them from the 
band drop-down list.

Load the airphoto dataset into the Algorithm
Generally it is more useful to display the Red, Green and Blue bands of color 
airphotos together, and not singly. 

1 Close the image window, but leave the Algorithm  dialog open.

The layer list and process diagram in the Algorithm dialog will now be blank.

2 On the ER Mapper Standard  toolbar, click the Open  button.

The Open  file chooser dialog box appears.

3 From the Directories  menu (on the Input dialog), select the path ending 
with \examples . 

select band

Open  button
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4 Double-click on the directory named ‘functions_and_features’ and then 
‘airphoto_tutorial’ to open it.

5 Double-click on the image file named ‘1_3_rect.tif’ to load it.

ER Mapper will now load the Red, Green and Blue bands of the airphoto into 
Green and Blue layers, and display the image in color.

If you open an image by clicking on the Open   or selecting Open...  from the 

File  menu, ER Mapper will automatically display the image according to the 
number of bands in the image. In this instance, the image has three bands, so
ER Mapper displays the image as RGB.

Note: It is often preferable to use the Image Display and Mosaic Wizard   to 

open and display an image because it gives you more control over how the im
displayed. This is described later in Chapter 6, “Assembling image mosaics”.

2: Selecting layers and adjusting contrast

Select the Layer tab in the Algorithm dialog
1 In the Algorithm  dialog, select the Layer tab.

The contents of the right side of the Algorithm dialog change to show the proc
diagram option buttons.

2 If needed, drag one side of the Algorithm  dialog to widen it until you can 
see all the option buttons above.

Objectives Learn to view different bands in the dataset and use the Transform dialog 
options to adjust the image contrast. Also learn about image histograms.

Select Layer tab
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Tip: When you resize or reposition a dialog box, ER Mapper automatically rememb
this the next time you open it. This lets you setup your work environment as y
like.

Display the histogram for the Red layer

1 In the Algorithm  dialog, click on the right-hand Edit Transform Limits  
button (blue) in the Red layer process diagram. 

The Transform  dialog box opens showing a histogram of the data values in th
current layer (Red in this case), and options for modifying the image contrast.

A histogram is a graphical display of the relative frequency distribution of values
an image. Peaks in the histogram show where there are many pixels with sim
data values, and sometimes indicate identifiable features in an image.

Edit Transform Limits button

histogram of
red band values

transform line

actual range of
values in red band

color bar showing
colors in current
Color Table
(greyscale)
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The transform line maps the image data values on the X-axis to the output disp
values on the Y-axis. A linear transform line, as shown above, creates the sam
input and output histograms. A non-linear transform line causes the output 
histogram to be different to the input histogram.

The “Actual Input Limits” field shows the actual range of values in the current b
of the dataset. In this case, the red band values fill the possible dynamic rang
zero to 255.

Apply a 99% clip transform to the data

1 On the Transform  dialog, click the Create autoclip transform  button.

ER Mapper automatically sets the transform line into a position that clips off o
percent of the data values (0.5% from the low end and 0.5% from the high en
This is called “autoclipping” since ER Mapper analyzes the histogram for the 
selected layer (and automatically positions the transform line for you. Autoclipp
is the most commonly used contrast enhancement technique for image datas

Note: Autoclipping is not always desirable for airphotos (as opposed to satellite ima
because airphotos often contain data in the areas that are clipped. This partic
image is a good example of where there is a significant amount of data in the 
values. 

Tip: You can set the percentage used for the autoclip function by double-clicking o

 button. Values between 90 and 99.5 are usually used. Lower values crea

stronger contrast, but also saturate more of the brightest and darkest features
default is 99 percent.

Create autoclip transform button
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Apply a Histogram equalize transform to the data

1 On the Transform  dialog, click the Histogram equalize   button.

Tip: Pass the mouse over the button to see the button name (tooltip).

ER Mapper creates a complex piecewise linear transform line and updates th
image. Notice that in this case the overall contrast is maximized, but detail ma
obscured (saturated) in the brightest and darkest features.

Histogram equalization (also called uniform distribution stretching) automaticall
adjusts the transform line for the selected layer so that image values are assig
display levels based on their frequency of occurrence. More display values ar
assigned to the most frequently occurring portion of the histogram, so the gre
contrast enhancement occurs in the data range with the most values (peaks in
histogram). Histogram equalization tries to create and approximately equal nu
of each color in the image, and usually creates an image with very strong con
In some cases, it can also saturate areas which can obscure detail. 

Note: The transforms must be set for each layer individually. Use the Transform  dialog 
R, G and B buttons to select the required layer.

Use 99% Contrast Enhancement button
Now you will learn to use a faster, easier way to adjust the image contrast.

Histogram equalize  button
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1 On the main ER Mapper menu, click the 99% Contrast Enhancement  

button.

ER Mapper runs the algorithm again to display the airphoto, and automatically
adjusts the contrast for all the layers for you. This button performs the followin
sequence or actions for you automatically:

Process->Limits to Actual->Process->99% autoclip->Process

Note: Again, the 99% Contrast Enhancement is not always desirable for airphotos 
because it could remove important data from the image. It is included in this 
tutorial for descriptive purposes only.

Tip: The Refresh  , 99% Contrast Enhancement  and STOP  buttons 

are located on both the main menu and the Algorithm  dialog. The STOP button 
ceases all processing so you don’t have to wait for the processing to finish if y
make a mistake. 

3: Labelling and saving the algorithm

In order to save your image and view it later, you need to save the processing
you defined previously as an algorithm file on disk. Note that you are not creat
new image file, you are only saving a text description of the steps required to 
enhance your original airphoto image.

Objectives Learn to specify description labels, titles, and comments for an algorithm, and
save the algorithm processing steps to a file so you can view it later.

99% Contrast Enhancement
button
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Enter a description for the entire algorithm
1 In the Algorithm  dialog, select the text in the Description  text field (it 

currently reads ‘No Description’).

(To select the text, either drag through it, or triple-click to select the entire line

2 Type the following text, then press Enter or Return on your keyboard:

airphoto in RGB

This text now becomes a brief description for the entire algorithm.

Save the processing steps to an algorithm file on disk
1 From the File  menu (on the main menu), select Save As... .

The Save As...  file chooser dialog opens.

2 In the Files of Type:  field, select ‘ER Mapper Algorithm (.alg)

3 From the Directories  menu, select the path ending with the text \examples . 
(The portion of the path name preceding it is specific to your site.)

4 Double-click on the directory named ‘Miscellaneous’ and then ‘Tutorial’ to 
open it. 

5 In the Save As:  text field, click to place the cursor, then type the following 
name for the algorithm file:

Airphoto_RGB

6 Click the Apply button to save the algorithm and leave the dialog open.

Your algorithm is now saved to an algorithm file on disk.

Add comments to the algorithm
1 On the Save As...  dialog, click the Comments...  button.

A dialog box appears titled with the algorithm path and file name, and a text ar
type comments about your algorithm. The cursor is already active.

2 In the comments dialog, type the following information to describe your 
algorithm:

This algorithm displays the red, green and blue bands of an 
airphoto as a greyscale algorithm. A 99% autoclip transform is used

to increase image contrast.

3 Click OK on the comments dialog to save your comments.

4 Click OK on the Save As...  dialog close it.
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Open a second image window
1 On the Standard toolbar (on the main menu), click the New Image Window  

 button. 

ER Mapper opens a new image window (this is a shortcut for selecting New from 
the File  menu). Drag the new window to the lower left part of the screen (so yo
can see all or most of the other image window). 

Open the RGB algorithm you created earlier

1 On the main menu, click on the Open  button. 

The Open file chooser dialog appears. (This is a shortcut for selecting Open...  
from the File  menu.)

2 From the Directories  menu, select the path ending with the text \examples .

3 From the Files of Type:  list, select ‘ER Mapper Algorithm (.alg)’.

4 Double-click on the ‘Miscellaneous\Tutorial’ directory to open it.

Your ‘Airphoto_RGB’ algorithm name should appear in the list.

5 Click once on your algorithm name to highlight it (do not double-click).

6 Click the Apply  button to load and process the algorithm without closing the 
Open dialog box.

ER Mapper runs the algorithm and displays the enhanced airphoto dataset in 
image window. It looks identical to the other image since they both use the sa
algorithm and dataset.

View the algorithm comments
1 On the Open dialog, click the Comments...  button.

The dialog box opens showing the comments you entered for your algorithm. 
These comments can be very helpful to others who use or display your algorit
and they are a good way to document the procedures you used to create it.

2 Click Cancel  on the comments dialog box to close it.

Objectives Learn to reload and display the algorithm you just created.
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Close both image windows and the Algorithm dialog
1 Close both image windows:

2 On the Algorithm  dialog, click the Close  button.

Only the ER Mapper main menu is now open on the screen.

• Load and display an image dataset as an RGB image

• Use transforms to adjust the image contrast

• Add text labels and comments to an algorithm

• Save the processing algorithm to disk

• Reload and view the saved algorithm

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Using GeoTIFF/
TFW images

This chapter explains how you can open and use GeoTIFF images and TIFF im
with TFW files in ER Mapper

Georeferencing information
You can mosaic images only if they contain georeferencing information; i.e. th
which defines where the image is geographically located. The ER Mapper Ra
Dataset format has a header file (.ers), separate from the data file which conta
the necessary georeferencing information. The ECW compressed format has 
georeferencing information embedded in the data file. GeoTIFF and DOQQ a
examples of external formats that also have embedded georeferencing inform
Other formats can have associated ‘World’ or ‘Header (.hdr)’ files, similar to .e
header files, that contain the georeferencing information. 

ER Mapper can create .ers header files to hold georeferencing and statistical 
information for image files in all supported formats. ER Mapper uses the 
information in a .ers header file in preference to that embedded in the image d
file or contained in an associated ‘World’ file.
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About GeoTIFF/TFW
There are two ways of including georeferencing information with raster image
the TIFF format (Tagged Image File Format) The first way is to use an 
accompanying text file, called a ‘World’ File. The second way is to incorporate
information directly into specially identified tags in the TIFF file.  In this case, t
TIFF file is known as a GeoTiff. 

GeoTIFF
GeoTIFF is an industry-wide standard which has been developed by several 
organizations in the GIS community for specifying cartographic information in 
TIFF tags. Geographic information is embedded in the TIFF data file in the form
descriptive tags. 

TFW
The TFW file is a text file which contains georeferencing information for an 
associated raw TIFF file. Known as a World file, it contains the following 
information:

• x resolution 

• amount of translation 

• amount of rotation 

• negative of the y resolution 

• x ground coordinate of pixel 1,1 (upper left) 

• y ground coordinate of pixel 1,1 (upper left)

World files are not restricted to TIFF images, and are generally named the sam
the associated image file with a "W" appended.  For example, if the image file
named ‘image1.TIF’, the corresponding world file is named ‘image1.TFW’.

GeoTIFF/TFW and foot-based projections

GeoTIFF
GeoTIFF images do not have a standard unit (i.e feet or meters) for the cell si
Generally the units are the same as those for the projection (i.e. cell size is spe
in feet for foot-based projections, and meters for meter based projections). 
ER Mapper always interprets the cell size to be in meters, even for foot-based
projections. This could cause problems when you open a GeoTIFF image (e.g
created with MapInfo® or ArcView GIS™) with a foot-based projection in 
ER Mapper for processing, and then save it for use in the original or another 
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application. ER Mapper solves this potential problem by calculating the correct
sizes in meters when opening a GeoTIFF image with a foot-based projection.
then converts the cell sizes back to feet if you save the image in GeoTIFF or E
compressed format. 

TFW
World files have the additional problem of not having datum or projection 
information. Not knowing the projection, ER Mapper is not able to determine 
whether to convert the cell sizes to meters, as it can with GeoTIFF images.

For this reason, ER Mapper 6.1 introduced the Change Projection/Datum/Cell 
Size wizard which enables you to edit the .ers ER Mapper header file associa
with the image. It creates a new .ers header file if one does not already exist. 
ER Mapper will then use this information in the .ers header file instead of that
the TFW World file. 

With this wizard you can specify the following information:

• datum and projection. 

• accept the existing cell size or you can enter a new cell size. 

• recalculate the cell sizes to be the correct value in meters.

Caution: Be careful that you enter the correct information. The wizard only edits the he
file, but does not reproject the image.

Hands-on exercises
These exercises give you practice using ER Mapper’s Change Projection/Datu
Cell Size Wizard to edit TFW file information

• Open a TIFF image in ER Mapper

• Use the Change Projection/Datum/Cell Size Wizard to edit the header informa

• Save the TIFF file in GeoTIFF format.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen.
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1: Edit the TIFF image header

Examine the current header information
1 Using Windows Explorer  (or similar) temporarily rename the ‘1_3_rect.tfw’ 

file in the ‘\examples\Functions_And_Features’ directory.

This is the ‘World’ file associated with the ‘1_3_rect.tif’ image file. Renaming i
effectively disassociates it from the image file.

2 On the ER Mapper Common Functions  toolbar, click on the Load Dataset  

 button.

3 On the Raster Dataset dialog, select ‘GeoTIFF/TIFF(.tif)’ in the Files of 
Type  field.

4 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

5 Double_click on the ‘Functions_and_Features’ directory to open it.

6 Double_click on the ‘airphoto_tutorial’ directory.

7 Click on the image dataset ‘1_3_rect.tif’ to select it. Do not load it.

Leave the Raster Dataset dialog box open.

Objectives Learn how to use ER Mapper’s Change Datum/Projection/Cell Size Wizard to
create a .ers header file for a TIFF image.
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8 Click on the Info button to display the Dataset Information  dialog box.

Notice that the Geodetic Datum and Map Projection fields are both ‘RAW’. Th
indicates that the image does not have any georeferencing information.

9 Click on the Dataset Information  dialog Close  button.

10 Using Windows Explorer (or similar), restore the ‘1_3_rect.tfw’ file to its 
correct name. This will re-associate it with the ‘1_3_rect.tif’ image file.
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11 Click on the Raster Dataset dialog Info...  button once again open the 
Dataset Information  dialog box.

The image now has Datum, Projection and Cell Size information, which 
ER Mapper extracts from the TFW file.

The TFW file contains the following information

• The X and Y cell size dimensions

• The real world coordinates of the image reference point, which is located in th
middle of the top left cell.

Note: TFW files do not contain Datum and Projection information, so ER Mapper 
defaults to displaying them as ‘WGS84’ and ‘LOCAL’. Also the cell sizes could
in feet whereas ER Mapper always assumes them to be in meters.

12 Click on the Dataset Information  dialog Close  button.

13 Click on the Raster Dataset  dialog Cancel  button to close the dialog.

Open the Change Datum/Projection/Cell size wizard
1 From the Toolbars  menu, select the Batch Processing  toolbar.

2 Click on the  button to open the Change Datum/Projection/Cell Size  
wizard.
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The first page of the wizard explains the purpose and usage of the wizard. Yo
obtain more information by clicking on the Additional help  button.

3 Click on the wizard Next>  button.

4 Click on the file chooser button  on the Input file  field.

5 On the Select File dialog, select ‘GeoTIFF/TIFF(.tif)’ in the Files of Type  
field.

6 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

7 Double-click on the ‘Functions_and_Features’ directory to open it.

8 Double-click on the ‘airphoto_tutorial’ directory.

9 Double-click on the image dataset ‘1_3_rect.tif’ to select it.

10 Select ‘This image only’ for the search criteria.

You can do batch conversions on a number of image files in the same director
selecting the appropriate search criteria. This would be particularly useful if yo
intend mosaicing a large number of images, and need to edit their georeferen
information first.

11 Click on the wizard Next>  button.

The next wizard page contains the existing image information contained in the
TFW World file associated with the image. The wizard does not change the TF
file in any way, but rather creates a .ers header file with the new information.

Note: ER Mapper will ignore the World (TFW) file if a .ers header file already exists.
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12 Enter the changes to be included in the .ers header file.

13 Click on the chooser  button on the Datum  field.

14 In the Datum Chooser dialog box, double click on the ‘NAD83’ entry to 
select it.

15 Click on the chooser  button on the Projection  field.
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16 In the Projection Chooser  dialog box, select the ‘utm’ projection type from 
the left-hand list, and then double click on the ‘NUTM11’ projection in the 
right-hand list to select it.

17 Select ‘Do not change’ in the Cell Size  field.

The sizes are already in meters, so there is no need to convert them. If we we
using a foot-based projection, the sizes would most likely have been in feet, a
would thus have had to be converted to meters.

Note: ER Mapper always interprets the units to be meters. If you select the Convert to 
meters  option, the wizard will divide the displayed value by 3.048 so that it is 
correct in meters. The Convert to feet  option reverses the calculation.

18 Click on the Next>  button, and then click Next>  again on the Confirm 
changes  page.

The wizard will create a .ers header file for the TIFF image and edit it to include
datum, projection, cell size and cell size unit values you entered.

19 Click Close  on the status dialog, and Finish  on wizard page.

When you open the image in ER Mapper, ER Mapper will ignore the TFW Wo
file in favor of the .ers header file. You can now use ER Mapper to process the
image, and then save it in any of the supported formats including GeoTIFF or E
compressed.

Note: ER Mapper does not change the TFW World file. It creates a new .ers header
for use within ER Mapper, and then uses the information in the .ers header if 
image is saved with georeferencing information.
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Open the TIFF image
We will now open the TIFF image in ER Mapper.

1 Click on the Open  button on the Standard  toolbar.

2 On the Open  dialog, select ‘GeoTIFF/TIFF(.tif)’ in the Files of Type  field.

3 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

4 Double-click on the ‘Functions_and_Features’ directory to open it.

5 Double-click on the ‘airphoto_tutorial’ directory.

6 Double-click on the image dataset ‘1_3_rect.tif’ to load it into an algorithm.

ER Mapper will display the image .

View the TIFF image georeferencing information
1 On the ER Mapper Common Functions  toolbar, click on the Load Dataset  

 button.

2 On the Raster Dataset dialog, select ‘GeoTIFF/TIFF(.tif)’ in the Files of 
Type  field.

3 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

4 Double_click on the ‘Functions_and_Features’ directory to open it.

5 Double_click on the ‘airphoto_tutorial’ directory.

6 Click on the image dataset ‘1_3_rect.tif’ to select it. Do not load it.
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7 Click on the Info button to display the Dataset Information  dialog box.

Notice that the Geodetic Datum and Map Projection fields are what you enter
with the Change Datum/Projection/Cell size Wizard. ER Mapper extracts this 
information from the .ers header file.

8 Click on the Dataset Information  dialog Close  button and the Raster 
Dataset  dialog Cancel  button.

Save the TIFF image as GeoTIFF
You will now save the TIFF image in GeoTIFF format. ER Mapper will extract t
georeferencing information from the .ers header file and embed it in the GeoT
image data file.

1 From the File  menu, select Save As... .

2 On the Save As...  dialog box, in the Files of Type:  field, select ‘GeoTIFF/
TIFF’.

3 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

4 Double-click on the ‘Functions_and_Features’ directory to open it.

5 Double-click on the ‘airphoto_tutorial’ directory.

6 In the Save as:  field, enter “1_3_rect_geo,tif”. (The ‘.tif’ extension will be 
added automatically if you omit it.)
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7 Click OK to close the Save As...  and open the Save As GeoTIFF/TIFF  
dialog box.

8 On the Save As GeoTIFF/TIFF dialog box, click on the Defaults  button.

This ensures that the settings are the same as those of original TIFF image.

9 Click on the Options...  button to open the GeoTIFF Options  dialog box.

10 Select the Save Geotiff Information option and click on the OK button.

This specifies that the georeferencing information in the .ers header file is to b
included in the image data file. If you do not select this option, the image will b
saved as a normal TIFF file. Any georeferencing information would then have t
included in a separate TFW World file.

11 Make sure that the Maintain aspect ratio  and Delete output transforms  
options are both selected in the Save As GeoTIFF/TIFF  dialog box.

12 Click on the OK button.

ER Mapper indicates the progress of the save via a status dialog box.

Display the GeoTIFF image

1 On the Standard  toolbar, click the Open   button.

2 On the Open  dialog box, in the Files of Type:  field, select ‘GeoTIFF/TIFF’.

3 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

4 Double-click on the ‘Functions_and_Features’ directory to open it.

5 Double-click on the ‘airphoto_tutorial’ directory.

6 Double-click on the image file ‘1_3_rect_geo.tif’ to load it.

ER Mapper will display the same image as before.
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View the GeoTIFF georeferencing information
1 On the ER Mapper Common Functions  toolbar, click on the Load Dataset  

 button.

2 On the Raster Dataset dialog, select ‘GeoTIFF/TIFF(.tif)’ in the Files of 
Type  field.

3 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

4 Double_click on the ‘Functions_and_Features’ directory to open it.

5 Double_click on the ‘airphoto_tutorial’ directory.

6 Click on the image dataset ‘1_3_rect_geo.tif’ to select it. Do not load it.

7 Click on the Info button to display the Dataset Information  dialog box.

Notice that the Geodetic Datum and Map Projection fields are the same as tho
the original TIFF image. There is also no ‘1_3_rect_geo.ers’ header file, so 
ER Mapper extracts this information from the GeoTIFF file.

8 Click on the Dataset Information  dialog Close  button and the Raster 
Dataset  dialog Cancel  button.

Close all windows
1 Close all image windows using the window system controls:
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• For Windows, select Close  from the window control-menu.

2 Click Close  on the Algorithm  window to close it.

Only the ER Mapper main menu should be open on the screen.

• Use the Change Datum/Projection/Cell size Wizard to create and edit a .ers fi

• Save the TIFF image with georeferencing information in GeoTIFF format.

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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This chapter explains how to use the ER Mapper Geocoding Wizard to 
geometrically correct raw image data and orthorectify it to real world coordina
systems and map projections.
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About image rectification
In order to create a mosaic of two or more airphotos, you must geometrically 
correct the raw airphoto dataset to a known map coordinate system.

This geometric correction process is known as rectification.

The ER Mapper Ortho and Geocoding Wizard can perform four different types
rectification.

• Triangulation

• Polynomial

• Orthorectification using Ground Control Points (GCPs)

• Advanced Orthorectification using exterior orientation

The method you use, with its corresponding degree of accuracy, depends on 
amount of information you have about the sensor equipment, the platform it is
mounted on and the terrain being scanned or photographed.

For airphotos it is preferable to use Orthorectification rather than Triangulation
Polynomial. For this reason, this chapter concentrates on Orthorectification.

Note: Some airphoto datasets have already been rectified before being opened in 
ER Mapper. These include orthorectified datasets such as the USGS Digital O
Quad (DOQ) series, GeoTIFF images and others. In this case, you do not nee
rectify the dataset in ER Mapper, you only need to make sure the proper datu
projection, and other parameters are specified (usually using the dataset head
editor).

raw (uncorrected) airphoto airphoto corrected to the UTM
coordinate system
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Ground Control Points
A common way rectify an image is by selecting ground control points (GCPs) 
between the raw airphoto and a reference image or map, and then creating a 
output image that is rectified (or geocoded) to the real world coordinate system

A ground control point (GCP) is a point on the earth’s surface where both image 
coordinates (measured in rows and columns) and map coordinates (measured in 
degrees of latitude and longitude, meters, or feet) can be identified. Rectification is 
the process of using GCPs to transform the geometry of an image so that each
corresponds to a position in a real world coordinate system (such a UTM or S
Plane map projection). This process is sometimes called “geocoding” or 
“rubbersheeting” because the image data are stretched or compressed as ne
align with a real world map grid or coordinate system.

To perform a control point rectification, you need a raw and reference image

• The raw image is simply a digitized airphoto that has been imported into ER Map

• The reference image is any other dataset, hardcopy map, or set of known coordi
points that can be used to correct the raw image. You can use another airph
image that has already been rectified, a geocoded vector dataset, a hardcop
mounted on a digitizing table, or GPS survey points of known features in your im
(such as buildings or road intersections).

About orthorectification
Orthorectification is more accurate than Linear or Polynomial rectification beca
it corrects local and global distortions in the image by adjusting for camera 
characteristics, platform positions and terrain details. This is particularly impor
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for airphotos because they are generally of a higher resolution than satellite im
The following pictures demonstrate how airphoto images can be distorted by 
variations in terrain, and the effects of height correction in orthorectification.

It is possible to use Polynomial and Triangulation rectification to correct for ter
variations, provided you choose enough GCPs. The following table shows the
numbers of GCPs you would require for Polynomial rectification.

From the table you can see that, if the terrain is generally flat, you can use Lin
order Polynomial rectification with 6 GCPs. For satellite images covering large
areas, where you need to correct for the earth’s curvature, you will need Quad
order Polynomia1 rectification with 12 GCPs. For gently undulating terrain you
should use cubic order polynomial rectification with a recommended 20 GCPs

Polynomial GCP Requirements Terrain type

order Minimum Recommended

Linear 3 6

Quadratic 6 12

Cubic 10 20

nth Not possible Not possible

Orthorectified imageNon-orthorectified image
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Selecting this number of GCPs per image is time-consuming process that still
not rectify images with real-world type terrain. Triangulation rectification does 
allow you to rectify images with more rugged terrains, but can require hundred
manually selected GCPs per image. 

Orthorectification, on the other hand, requires you to enter only 4 to 6 GCPs, a
identify the positions of fiducial points on the edges of the image. You have to
supply the terrain details to the ER Mapper Geocoding Wizard in the form of a
DEM (Digital Elevation Model). If the terrain is relatively flat, you can use an 
average height value. 

Note: The ER Mapper orthorectification does not correct images for the curvature of
earth. This is only significant for individual images of areas that are longer tha
KMs, which precludes most airphotos.

DEM file
A DEM is an image that comprises regularly gridded Z (height) data. If the hei
information is only available as contours, breaklines or XYZ ascii files, you can
the ER Mapper Gridding Wizard to create a DEM. Refer to the ER Mapper Us
Guide for information on the Gridding Wizard. The accuracy of the 
orthorectification depends on the resolution of the DEM. The following table gi
a rough guide to the DEM resolutions required:

Camera file
ER Mapper stores camera characteristics in a camera file for use by the Geoc
Wizard. The camera file information is derived from a camera calibration repo

Advanced orthorectification
In the case of Advanced Orthorectification, the image data supplier provides 
exterior orientation values that describe the exact position of the aircraft at the
the image was taken, and how this relates to the image. This does away with 
necessity to plot Ground Control Points. The following exterior orientation 
parameters are specified:

Airphoto scale Required accuracy Height data

1:10,000 - 1:15,000 1 - 2 meters 1 - 2 meter contours

1:20,000 - 1:30,000 2 - 5 meters 5 meter contours

1:40,000+ 5+ meters 10 meter contours
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Attitude omega The tilt angle (roll) of the aircraft; i.e. the rotation abou
the X axis (direction of travel).

Attitude phi The swing angle (pitch) of the aircraft; i.e the rotation 
about the Y axis.

Attitude kappa The azimuth angle (yaw)of the aircraft; i.e the rotation
about the Z axis.

Exposure center XYZ The co-ordinates of the exposure center of the image.

If you do not have the exterior orientation parameters, then you have to specif
about 4 to 6 GCPs for the Geocoding Wizard to compute them.

Caution: The format of exterior orientation parameters generated by different 
photogrammetry devices can vary considerably from device to device, and yo
might need to modify them to be compatible with ER Mapper.

Input data requirements
You must have the following information available to able to use the Geocodin
Wizard to orthorectify an image:

• Camera file containing camera calibration information

• DEM file (You can enter an average height if the terrain is relatively flat)

• Exterior orientation (Only for Advanced Orthorectification. Otherwise you mus
select GCPs)

• GCPs referenced by their XYZ coordinates.(Not required if you have the exter
orientation parameters.
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The diagram below illustrates the required inputs for orthorectification.

Note: The Geocoding Wizard only supports images in ER Mapper Raster Dataset fo
If the image is in another format, then you should either save it in ER Mapper 
Raster Dataset format or use the import utilities to import it as an ER Mapper 
Raster Dataset.

Hands-on exercises
These exercises give you practice using ER Mapper’s Geocoding Wizard to 
orthorectify an airphoto image.

• Use the Geocoding Wizard to orthorectify an airphoto

• Use the Camera Wizard to create a Camera File from a calibration report

• Locate fiducial marks on an airphoto

• Pick suitable Ground Control Points (GCPs)

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Geocoding Wizard Orthorectification

Camera
Wizard

Camera FileDEM Roll
Pitch
Yaw
Exposure
Center

Exterior Orientation

Ground 
Control
Points

OR

Uncorrected
image (airphoto)

Corrected
image (orthophoto)

OR average
height

Camera
Calibration
Report
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In these exercises you will use the Geocoding Wizard to orthorectify the airph
image of San Diego taken in 1997. The example images are used with permis
from Aerial Fotobank.

1: Orthorectify an airphoto using GCPs

Open the Geocoding Wizard

1 Click on the Ortho and Geocoding Wizard   button in the Common 
Functions  toolbar.

The Geocoding Wizard will open with the 1) Start  tab selected.

2 Click the Load Algorithm or Dataset  button in the Input file:  field to 
open the file chooser. 

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn how to use ER Mapper’s Geocoding Wizard to orthorectify an airphoto. 
Use the Camera Wizard to create a Camera File with given calibration 
parameters.
Select Ground Control Points
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3 From the Directories  menu, select the path ending with the text \examples .

4 Select the directory ‘Applications\,Airphoto\1_Geocoding’ and then double-
click on ‘San_Diego_Airphoto_34_not_rectified.ers’ to select it.

5 Select the Geocoding Wizard Orthorectify using ground control points  
option.

In this example, you do not have exterior orientation parameters which provid
information on the position of the platform or aircraft. Instead, you will pick GC
so that the wizard can compute the exterior orientation parameters. If these 
parameters were available, you could have chosen the Orthorectify using 
exterior orientation  option.

6 Select the 2) Ortho Setup  tab.

Enter terrain and camera details

This tab allows you to enter the terrain details in the form of a DEM or as an 
average height value. Obviously, using a DEM would produce a more accurat
result. However, if the terrain is relatively flat, you can enter an average value.
this example you will enter the name of a DEM file.

You supply the camera details to the Geocoding Wizard in the form of a came
file. If the applicable camera file does not exist, you can use the Camera Wiza
create one.

1 Select the Use a DEM file as height option in the DEM Setup  box.
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Notice that the DEM Setup box changes according to the option that you choo
Because you selected the Use a DEM file as height  option, the DEM Setup box 
displays a file and a band chooser for you to select the DEM file and the requ
data band.

2 Click on the Load input DEM File   button to open the file chooser.

3 Select the file ‘San_Diego_DEM.ers’ from the 
‘examples\Applications\,Airphoto\1_Geocoding’ directory and click on the 
OK button to return to the Geocoding Wizard.

4 Click on the Camera Wizard   button to open the Camera Wizard 
dialog.

Create a Camera file

The Camera Wizard creates a Camera file for the Geocoding Wizard to use. It
this by providing a number of dialog boxes for you to enter camera calibration
information. You normally get this information from a camera calibration report
you do not have a valid calibration report for the camera that was used to take
image, you can use a generic report for that camera model. This could result 
some inaccuracies.

1 Click on the Create new option to create a new Camera File.

You could edit an existing Camera File, in which case the wizard provides you 
the Camera file:  field and chooser to enter the name of the existing file.
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2 Click on the Next>  button to go to the Camera identification page.

The information you enter here is not used by the Geocoding Wizard. Therefo
can be omitted. It is, however, a good idea to include it because it is a means 
identifying the camera and the calibration report in the future.

3 Enter the following information in the applicable fields:

Manufacturer: Wild

Model: RC20

Lens serial number: 13115

Date calibrated: Day: 31 Month:10 Year: 1998
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4 Click on the Next>  button to go to the ‘Camera attributes page’.

Use this page to enter information on the focal length of the camera lens. The
Camera Wizard uses this information, so it must be entered. In addition, you c
enter information on the position of the Principal Point relative to the lens cente
a measure of lens distortion. Any distortion in the lens would cause the princip
point to be offset from the lens center.

5 Enter the following information in the applicable fields:

Focal length:  152.793

X offset to principal point:  0

Y offset to principal point:  0
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This is the ideal case where the principal point is at the lens center on the foc
plane. Lens distortion could cause it to be slightly off-center, and this is represe
by the X and Y offsets to the principal point. The diagram below illustrates this
exaggerating the lens distortion.

Note: While the focal length information is critical, you can generally set the principa
point offsets to 0 because lens distortion will be negligible compared to that 
introduced by the scanner.

6 Click on the Next>  button to go to the ‘Number of Fiducial points’ page

Principal
point

Focal length

Lens

Y offset

X offset

Lens center
Focal
plane
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Aerial photography cameras insert Fiducial marks around the edges of the airp
images. Different cameras insert these marks in different places on the image
Geocoding Wizard uses the positions of these marks to relate the image to th
camera model. Use this page to specify where the camera has placed the Fid
marks. If you specify four Fiducial marks where the camera has, in fact, insert
eight, the Geocoding Wizard will only take into consideration the four you 
specified.

7 Select the All 8 option; indicating that the Fiducial points are on the four 
corners and the middle of edges of the image.

8 Click on the Next>  button to got to the ‘Fiducial point offsets’ page.

This page enables you to specify the positions of the fiducial points relative to
principal point. 

9 Enter the following values in the applicable fields:

Top left X:-105.99 Y:106.01

Middle top X: 0.011 Y: 110.01

Top right X:106.01 Y:106.02

Middle left X:-109.99 Y: 0.012

Middle right X:110.01 Y: 0.013

Bottom left X:-105.99 Y:-105.99

Middle bottom X:-0.005 Y: -109.99

Bottom right X:106.0l Y:-105.99
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Note: The data strip is not always on the left side of the image. Ensure that your sca
image has the data strip on the same side as what is specified in the Camera 
not, you will have to either change the Camera file or rotate the scanned imag

10 Click on the Next>  button to go to the ‘Finish’ page.

11 Click the Save  button in the Camera file:  field to open the file chooser 
to select a directory and file name to which to save the new camera file. 

12 From the Directories  menu, select the path ending with the text \examples .

13 Select the directory ‘functions_and_features\airphoto_tutorial’, and then 
enter ‘camera_ <your initials> ’ in the Save as:  field.

14 Click on the OK button to return to the Camera Wizard.

The file name and directory you entered should now be displayed in the Camera 
file: field.

15 Click on the Finish  button to return to the Geocoding Wizard.

16 Click the Load Camera File  button in the Geocoding Wizard Camera 
file:  field to open the file chooser. 

17 From the Directories  menu, select the path ending with the text \examples .

18 Select the directory ‘functions_and_features\airphoto_tutorial’, and then 
double-click on the ‘camera_<your initials>’ file you saved.

19 Click on the 3) Fiducial Point Edit  tab.
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Edit the fiducial points

This wizard page enables you to enter the locations of the fiducial points on th
image into ER Mapper. 

Tip: Images scanned by lower quality scanners often have fiducial points that are 
difficult to see. It often helps to increase the image contrast before orthorectify
them.
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ER mapper opens two image windows one in OVERVIEW ROAM mode, and t
other in ZOOM mode.

1 Select the Auto zoom  option. This causes the ZOOM window to 
automatically zoom to the selected fiducial mark.

2 Select the Pointer Tool   on the Standard  toolbar.

3 On the table, select ‘Top Left’ in the ‘Name’ column.

ZOOM OVERVIEW ROAM
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4 In the OVERVIEW ROAM window, click on the Fiducial mark on the top left 
corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

5 On the table, select ‘Top Right’ in the ‘Name’ column.

6 In the OVERVIEW ROAM window, click on the Fiducial mark on the top right 
corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

7 On the table, select ‘Bottom Left’ in the ‘Name’ column.

8 In the OVERVIEW ROAM window, click on the Fiducial mark on the bottom 
left corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

9 On the table, select ‘Bottom Right’ in the ‘Name’ column.

10 In the OVERVIEW ROAM window, click on the Fiducial mark on the bottom 
right corner of the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

11 On the table, select ‘Middle Left’ in the ‘Name’ column.
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12 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the left side of the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

13 On the table, select ‘Middle Right’ in the ‘Name’ column.

14 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the right side of the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

15 On the table, select ‘Middle Top’ in the ‘Name’ column.

16 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the top the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

17 On the table, select ‘Middle Bottom’ in the ‘Name’ column.

18 In the OVERVIEW ROAM window, click on the Fiducial mark on the middle 
of the bottom of the image. 

The image in the ZOOM window will automatically zoom to the selected fiduci
mark. Use this to adjust the position of the cursor to the center of the red circl

After selecting the fiducial markers, the table on the Fiducial Point Edit  tab 
should be similar to what is shown below.

The RMS column should show values of less than 1.00. 

The image window should now have all the fiducial points labelled.
ER Mapper Airphoto Mosaic Tutorial 73



Chapter 4 Image orthorectification ● 1: Orthorectify an airphoto using GCPs

ge, 

ate 

es 
19 If necessary, select the Errors  option, and adjust the position of the 
selections in the direction of the indicated errors.

The x10 option enlarges the error markers for a more accurate indication.

20 Click on the 4) GCP Setup  tab.

Setup Ground Control Points

The GCP Setup tab lets you specify the way that you want to choose control 
points. Control points may be entered manually, chosen from a reference ima
chosen from a digitizing tablet, or chosen using a combination of these three 
methods.

In this exercise, you will use a previously orthorectified reference image to loc
GCPs.

1 In the GCP Picking Method  box, select Geocoded image, vectors or 
algorithm  option.

This tells ER Mapper you plan to pick corresponding points between two imag
on the screen.

2 Click the Load Corrected Algorithm or Dataset   file chooser button.

3 Choose ‘ER Mapper Raster Dataset (.ers)’ in the Files of Type: field.

4 From the Directories  menu on the file chooser dialog, select the path 
ending with the text \examples .

5 Double_click on the ‘Applications’ directory to open it.
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6 Double-click on the ‘Airphoto\1_Geocoding’ directory to open it, then 
double-click on ‘San_Diego_Airphoto_34_rectified.ers’ to load it.

This is the already rectified image containing coordinate information.

Setup parameters for the image rectification
The To geodetic datum , To geodetic projection  and To Coordinates , 
fields in the Output Coordinate Space box show the datum, projection and 
coordinate type for the output rectified file you will create. These parameters a
included automatically from the ‘CORRECTED’ (rectified) airphoto image.

7 Click on the Change...  button to open the Geocoding Wizard Output 
Coordinate Space  dialog.

8 If necessary, change the settings to what is displayed above. 

9 Click OK on the Geocoding Wizard Output Coordinate Space  dialog to 
close it.

10 Select the Geocoding Wizard 5) GCP Edit  tab.
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Edit Ground Control Points

ER Mapper opens several image windows and dialog boxes. You should see a
screen setup similar to this one:

Note: If your system does not position the windows automatically, rearrange them a
shown above before proceeding.

ER Mapper
main menu

Geocoding Wizard
dialog box

 

UNCORRECTED
GCP ZOOM
WINDOW

CORRECTED GCP
ZOOM WINDOW

UNCORRECTED
GCP (OVERVIEW
ROAM geolink)
WINDOW

CORRECTED GCP
(OVERVIEW ROAM
geolink) WINDOW
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Pick a GCP in the upper-left part of the reference image

Note: Make sure the main ER Mapper menu is not hidden by the image windows – m
it slightly if needed so you can easily access the toolbars.

1 On the Geocoding Wizard GCP Edit tab, select Auto zoom .

The ZOOM windows will now automatically zoom into the point selected in the
corresponding OVERVIEW ROAM windows.

Note: In this example, the reference image extents are, unfortunately, much smaller
those of the raw image. This means the you will have to confine the GCPs to 
within the reference image extents. You should try to select them over as wide
area as possible, so the first four should be in the four corners of the referenc
image.

2 Click on a well defined feature in the ‘UNCORRECTED GCP (OVERVIEW 
ROAM geolink)’ window to select it.

The ‘UNCORRECTED GCP ZOOM’ window will zoom ito the selected point

3 Click once in the ‘CORRECTED GCP (OVERVIEW ROAM geolink)’ window 
to activate it, then click on the same feature to select it as a GCP.

The ‘CORRECTED GCP ZOOM’ window will zoom ito the selected point

4 Use the two ZOOM windows to adjust the positions of the GCP.

5 Click on the Set Z height from DEM   button to fill in the ‘Height’ field for 

that GCP.

The wizard will compute the height at that position from the 
‘San_Diego_DEM.ers’ DEM file that you specified earlier. The accuracy of this
value depends on the DEM resolution. If you have a definite height value for t
GCP, you can also click on the ‘Height’ field and enter it manually.

You have now picked a GCP in the image.

Pick a second GCP in the lower-left of the reference image

6 On the Geocoding Wizard Edit GCP  dialog, click the Add new GCP   

button.

7 Click on a well defined feature in the ‘UNCORRECTED GCP (OVERVIEW 
ROAM geolink)’ window to select it.
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The ‘UNCORRECTED GCP ZOOM’ window will zoom into the selected point

8 Click once in the ‘CORRECTED GCP (OVERVIEW ROAM geolink)’ window 
to activate it, then click on the same feature to select it as a GCP.

The ‘CORRECTED GCP ZOOM’ window will zoom ito the selected point

9 Use the two ZOOM windows to adjust the positions of the GCP.

10 Click on the Set Z height from DEM   button to fill in the ‘Height’ field for 

that GCP.

The wizard will compute the height at that position from the 
‘San_Diego_DEM.ers’ DEM file that you specified earlier. The accuracy of this
value depends on the DEM resolution. If you have a definite height value for t
GCP, you can also click on the ‘Height’ field and insert it manually.

You have now picked a second GCP in the image.

11 Following the above steps, pick another four GCPs near the upper-right, 
lower-right and middle of the reference image. 

The more GCPs you pick, the lower the possibility of errors. For orthorectifica
you need at least four, with six being the recommended number.

Try some other features on the Geocoding Wizard GCP Edit dialog
1 In the Geocoding Wizard GCP Edit dialog, click on any GCP number under 

the ‘Name’ column.

ER Mapper moves the crosshairs to highlight that point in all the ‘OVERVIEW 
ROAM’ and ‘ZOOM’ windows.

2 Turn off the Auto Zoom option at the bottom.

3 Click on any GCP number under the ‘Name’ column.

ER Mapper moves the crosshairs to highlight that point in the ‘OVERVIEW 
ROAM’ windows, but not the ‘ZOOM’ windows.

4 Click on the Zoom to current GCP   button.

ER Mapper zooms into the selected GCP in the “ZOOM’ windows.

5 Select the number text for a GCP under the ‘Name’ column, and type a 
short name.

You can give GCPs text labels as well as numbers to help identify them.

6 Click on the text ‘On’ in the second column for any GCP.
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The text changes to ‘Off’ and all the RMS errors are recomputed without includ
that GCP. (This is an easy way to see how the positional error of any GCP 
influences the RMS of the others. For example, turning off a GCP with a large
RMS often reduces the RMS of the others.) This can be important when choo
which GCPs will be used for the final image rectification.

7 Turn off other GCPs to see the effect, but turn all on again when finished.

8 Click on the text ‘Edit’ in the third column for any GCP.

The text changes to ‘No’ and the “X” and number marking it in the image turns
green. This effectively “locks” a GCP so it cannot be edited (that is, clicking in
image windows do not redefine it’s position). This is useful when you have sev
very good GCPs and you to lock them to avoid accidentally changing them.

9 Turn on the Errors option.

The magnitude and direction of the calculated positional error are shown 
graphically by a line for each GCP on the image. (If you have very small RMS
errors you may not see the error line, even if you increase the line length by a 
of 10 using the x10 option.)

10 Turn on the Grid option.

A polynomial grid displays over all three image windows. This grid is a simple
“preview” of the way in which the FROM (raw) image pixels will be reprojected
onto the new coordinate grid of the TO image. (This grid is only an approximat
in reality the lines would be curved.)

11 Click the Add new GCP   button and select a point on the CORRECTED 

image. 

12 Click on the Calculate uncorrected point   button. The wizard will 
automatically position the corresponding GCP on the UNCORRECTED 
image. Use the ZOOM windows to adjust the GCP position.

This time saving facility is available once you have positioned four points.

13 Click Save on the Geocoding Wizard dialog. When asked confirm saving 
the GCPs to disk, click Yes.

This will save the geocoding information into the header file of the 
UNCORRECTED image.

14 Select the Geocoding Wizard 6) Rectify  tab.
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Rectify the image

1 Click the file chooser  button in the Output Info  box.

2 From the Directories  menu, select the path ending with \examples . 

3 Double-click on the ‘functions_and_features\airphoto_tutorial’ directory to 
open it.

4 Enter the filename ‘San_Diego_orthorectified ’ (start with your 
initials), then click OK.
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5 Click on the Edit Extents...  button to open the Geocode Output Extents  
dialog box.

This dialog allows you to specify how much of the orthorectified image you wan
save. You have three main options:

Maximum extents: Saves the whole image including any portion not visib
in the currently active image window.

Optimum extents: Automatically calculates the extents of airphotos to 
exclude the black edges around them.

Custom extents: Allows you to specify the top left and bottom right 
coordinates of the area to be included. If you click on t
Snapshot  button ER Mapper will automatically select
the extents of the visible part of the image in the 
currently active image window.
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6 Select the Custom extents option and enter the Easting/Northing values 
shown below.

These values are the extents coordinates for the reference image. Note that t
Latitude and Longitude values change automatically as you change the Eastin
and Northings values.

7 Click on the OK button to exit the Geocode Output Extents  dialog box. 
and return to the Geocoding Wizard

8 In the Resampling:  in the Cell Attributes box select ‘Nearest Neighbour’.

The Cell Attributes box also lets you resample the output image to a different 
size (Output Cell width and height), and specify a null cell value. If you do not
enter a null cell value, it will default to that in the reference image.

Note: Cells having the null cell value will be treated by ER Mapper as being transpa
This can be very useful if you want to remove black or white edges around 
individual images to be mosaiced. All you have to do is set the null cell value t
for black, or 255 for white. You must, however, use this with care because it ca
have the undesirable effect of rendering wanted black or white areas in the im
transparent as well. 

9 Click on the Save button to save the orthorectification parameters in the 
‘San_Diego_Airphoto_34 _not_rectified.ers’ header file.

You will use this in the next exercise.

10 Select Display rectified image  to display the image after it is rectified.

11 Click on the Save file and start rectification button.

ER Mapper opens a status dialog to indicate the progress of the rectification. 
should take approximately 10 minutes.

12 When the operation finishes, click OK of the successful completion dialog. 
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13 Click on the Close  button to exit the Geocoding Wizard.

You have now rectified the uncorrected airphoto image to correspond to the 1
North American Datum (NAD27) and UTM zone 11 (NUTM11) map projection

14 Do not close the image window with the orthorectified image

Evaluate the image orthorectification

1 On the main menu, click the Edit Algorithm   button to open the 
Algorithm  window.

2 The Algorithm window shows the Red, Green and Blue layers of the 
orthorectified image.

3 In the Algorithm  window, click on the Blue layer to select it.

4 Click the Load Dataset   button in the algorithm process diagram.

5 From the Directories  menu, select the path ending with \examples . 

6 Double-click on the ‘Applications’ directory to open it.

7 Double-click on the ‘Airphoto’ and then on ‘1_Geocoding’ directory to open 
it.

8 Click once on the image ‘San_Diego_Airphoto_34 _rectified.ers’ to select it, 
then click OK this layer only  button to load it into the Blue layer. (The Red 
and Green layers should still have the ‘<your 
Initials>_Airphoto_orthorectified’ image.)

9 Select B3:Blue  from the Blue layer’s Band Selection  drop-down list.

Display the two images to evaluate registration

1 Click the 99% Contrast Enhancement  toolbar button.

This image combines two different images–one in the Red and Green layers a
one in the Blue layer. If your images are well aligned the image appears norm
you see areas that are dominantly yellow or blue, this indicates poor registrati

2 On the Algorithm  window, turn off the Smoothing  option.

3 On the main menu, click the ZoomBox tool  toolbar button.

4 Drag a zoom box over a very small area of the image that contains land and 
water.
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Errors in registration appear as either blue or yellow pixels because this is wh
the two images do not align perfectly. This is a very simple way to evaluate th
registration of two images. If the RMS errors of your GCPs were generally les
than one, you should not see more that one pixel offsets or registration errors

Close all windows
1 Close all image windows using the window system controls:

2 Click Close  on the Algorithm  window to close it.

2: Orthorectify an airphoto using Exterior 
Orientation

In this exercise you will orthorectify the same image as in the previous exercis
This time, instead of using Ground Control Points, you will enter Exterior 
Orientation parameters which have been obtained from a photogrammetry, ae
triangulation or geoposition system external to ER Mapper. In the previous exe
you saved orthorectification parameters in the 
‘San_Diego_Airphoto_34_not_rectified.ers’ file. This means that you will not have
to re-enter them in this exercise.

Open the Geocoding Wizard

1 Click on the Ortho and Geocoding Wizard   button in the Common 
Functions  toolbar.

The Geocoding Wizard will open with the 1) Start  tab selected.

Objectives Learn how to use ER Mapper’s Geocoding Wizard to orthorectify an airphoto 
using Exterior Orientation parameters
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2 Click the Load Algorithm or Dataset  button in the Input file:  field to 
open the file chooser. 

3 From the Directories  menu, select the path ending with the text \examples .

4 Select the directory ‘Applications\,Airphoto\1_Geocoding’ and then double-
click on ‘San_Diego_Airphoto_34_not_rectified.ers’ to select it.

This is the same file as that you used in the previous exercise.

5 Select the Geocoding Wizard Orthorectify using exterior orientation 
option.

In this example, you enter exterior orientation parameters which provide 
information on the position of the platform or aircraft.

6 Select the 2) Ortho Setup  tab.

The fields in the Ortho Setup page should contain the information that you en
in the previous exercise because it was saved to the header file of the image b
orthorectified.

7 Click on the 3) Fiducial Point Edit  tab.

The fields in the Fiducial Point Edit page should also contain the information y
entered in the previous exercise.

8 Click on the 4) Exterior Orientation Setup  tab.
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Enter Exterior Orientation parameters

Exterior Orientation parameters contain information on the position of the platf
or aircraft at the time the image was taken. You would have to obtain this data 
a system external to ER Mapper. 

If these parameters are not available then you would use Ground Control Poin
in the previous exercise.

1 Enter the information in the relevant fields as shown in the table below:

Field name Description Enter value

Attitude omega The tilt angle (roll) of the 
aircraft; i.e. the rotation 
about the X axis (direction of 
travel).

0.024233136466399

Attitude phi The swing angle (pitch) of 
the aircraft; i.e the rotation 
about the Y axis.

0.028555797949162

Attitude kappa The azimuth angle (yaw)of 
the aircraft; i.e the rotation 
about the Z axis.

0.0019776681959326

Exposure center X The X co-ordinate of the 
exposure center of the image.

483681.44788264
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The following diagram illustrates the relationship between the parameters.

Note: The Phi, Kappa and Omega values can be negative or positive, depending on
direction of rotation.

Caution: The format of the exterior orientation values is not consistent for the different 
devices that can be used to generate them. Before using them on a set of airp
it is advisable to orthorectify one image using GCPs and then compare the re

2 Click on the Change.. . button to open the Geocoding Wizard Output 
Coordinate Space  dialog.

3 Enter the Datum , Projection  and Coord system type  as shown below

Exposure center Y The Y co-ordinate of the 
exposure center of the image.

3621463.0778646

Exposure center Z The Z co-ordinate of the 
exposure center of the image.

3182.9321414632

Scale The scale of the image 
expressed as a decimal value.

0.000048745007960398

Field name Description Enter value

X

YZ
Exposure
center

Kappa

Omega

Phi
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Tip: NUTM11 is a utm projection type.

4 Click on the 5) Rectify  tab.

Rectify the image

1 Click the file chooser  button in the Output Info  box.

2 From the Directories  menu, select the path ending with \examples . 

3 Double-click on the ‘functions_and_features\airphoto_tutorial’ directory to 
open it.

4 Enter the filename ‘San_Diego_orthorectified_advanced ’ (start with 
your initials), then click OK.

5 Click on the OK button to return to the Geocoding Wizard.

6 In the Resampling:  in the Cell Attributes box select ‘Nearest Neighbour’.

The Cell Attributes box also lets you resample the output image to a different 
size (Output Cell width and height), and specify a null cell value.

7 Click on the Save button to save the orthorectification parameters in the 
‘San_Diego_Airphoto_34 _not_rectified.ers’ header file.

8 Select Display rectified image  to display the image after it is rectified.

9 Click on the Save file and start rectification button.

ER Mapper opens a status dialog to indicate the progress of the rectification.

10 When the operation finishes, click OK on the successful completion dialog. 

11 Click on the Close  button to exit the Geocoding Wizard.

You have now rectified the uncorrected airphoto image to correspond to the 1
North American Datum (NAD27) and UTM zone 11 (NUTM11) map projection

12 Do not close the image window with the orthorectified image

Evaluate the image orthorectification

1 On the main menu, click the Edit Algorithm   button to open the 
Algorithm  window.

2 The Algorithm window shows the Red, Green and Blue layers of the 
orthorectified image.

3 In the Algorithm  window, click on the Blue layer to select it.
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4 Click the Load Dataset   button in the algorithm process diagram.

5 From the Directories  menu, select the path ending with \examples . 

6 Double-click on the ‘Applications’ directory to open it.

7 Double-click on the ‘Airphoto’ and then on ‘1_Geocoding’ directory to open 
it.

8 Click once on the image ‘San_Diego_Airphoto_34 _rectified.ers’ to select it, 
then click OK this layer only  button to load it into the Blue layer. (The Red 
and Green layers should still have the ‘<your 
Initials>_Airphoto_orthorectified_advanced’ image.)

9 Select B3:Blue  from the Blue layer’s Band Selection  drop-down list.

Display the two images to evaluate registration

1 Click the 99% Contrast Enhancement  toolbar button.

This image combines two different images–one in the Red and Green layers a
one in the Blue layer. If your images are well aligned the image appears norm
you see areas that are dominantly yellow or blue, this indicates poor registrati

2 On the Algorithm  window, turn off the Smoothing  option.

3 On the main menu, click the ZoomBox tool  toolbar button.

4 Drag a zoom box over a very small area of the image that contains land and 
water.

Errors in registration appear as either blue or yellow pixels because this is wh
the two images do not align perfectly. This is a very simple way to evaluate th
registration of two images. If the RMS errors of your GCPs were generally les
than one, you should not see more that one pixel offsets or registration errors

Close all windows
1 Close all image windows using the window system controls:

2 Click Close  on the Algorithm  window to close it.

Only the ER Mapper main menu should be open on the screen.

• Use the Camera Wizard to create a Camera File

• Select fiducial markers on an airphoto image

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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• Use options to modify the GCP display and edit GCPs

• Enter Exterior Orientation parameters for advanced orthorectification.

• Use the Geocoding Wizard to orthorectify a “raw” airphoto image to the chose
datum and map projection.
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images

This chapter describes how you would use the ER Mapper Geocoding Wizard
change an image projection or datum.

UTM and State Plane projections
An example of where you are likely to want to change the image projection or
datum is in the United States of America where your airphoto image could ha
Universal Transverse Mercator projection, and you need to mosaic it with ima
that have a State Plane projection. You can use the ER Mapper Geocoding W
to change from a UTM to the required State Plane projection.

UTM projections
UTM, Universal Transverse Mercator, is a system of world coordinates like latit
and longitude, from 80 degrees south latitude to 84 degrees north latitude, ex
the measurements are in meters and UTM lines are orthogonal (are always a
angles to each other).
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UTM Northing is the distance north from the equator in meters and Easting is
distance east from central meridians of (60) 6-degree-wide zones starting at 
longitude 180 degrees. Northing is also divided into 8-degree zones from sout
north using the letters C to X with the equator at M/N, (A,B and Y,Z being reser
for the UPS coordinate system at the poles).

All measurements are POSITIVE by incorporating a system of "false" easting 
northing by adding an arbitrary number to the central meridians (500,000m) a
10,000,000m to the distance south of the equator in the southern hemisphere

State plane projections
The United States of America use a system of map projections for various reg
This system is known as the “State Plane Coordinate System (SPCS)”. The 
Lambert Conformal Conic projection is the most widely used, with Transverse
Mercator projections being used for States with predominantly north to south 
extents. The panhandle of Alaska is mapped using the Oblique Mercator proje
The Lambert Conformal Conic is a conic projection usually based on two stan
parallels. It can represent the pole as a single point. This projection is good fo
mapping a region, continent and at medium or large scale.

Older maps are projected onto the Clarke 1866 spheroid with tie point at Mea
Ranch in Kansas (datum NAD27). More recent maps are projected onto the 1
datum (datum NAD83).

Constraints
The Geocoding wizard only supports images in the ER Mapper Raster Datase
format. Images in other formats, including ECW compressed, have to be origin
imported or saved as ER Mapper Raster datasets before you can reproject th
Because of the size of some images, you may have to reproject individual ima
before mosaicing them rather than reprojecting the whole mosaiced image.

Hands-on exercises
These exercises give you practice using ER Mapper’s Geocoding Wizard to ch
an image projection from a UTM to a State Plane.i

• Use the ER Mapper Import utilities to import a TIFF image into ER Mapper Ra
Dataset format.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:
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• Use the Geocoding Wizard to change an image projection.

1: Import an image into ER Mapper

For this exercise, you will import the TIFF image, ‘1_3_rect.tiff’, that you modifi
in Chapter 3, “Using GeoTIFF/TFW images”. For this reason you must do tha
exercise before starting this one.

You have to import this image as an ER Mapper Raster Dataset because the 
Geocoding Wizard supports only ER Mapper Raster Datasets.

Importing a TIFF image
To import a dataset from an external file into ER Mapper, you will use the impo
programs listed under the Utilities  menu in ER Mapper. In this case, you will 
import an airphoto that is in TIFF format. When you import a dataset into 
ER Mapper, it creates two files: and binary data file (in Band Interleaved by Lin
“BIL” format), and an ASCII header file with a “.ers” file extension:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn how to import a GeoTIFF image into ER Mapper.

1_3_rect.tif

Utilities

Import Graphics formats

TIFF (.tif)

airphoto.ers
(ER Mapper ASCII 

airphoto
(ER Mapper BIL data file)

header file)

Raster Translated Images
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You should have the following three files in your 
‘examples\Functions_And_Features\Airphoto_Tutorial’ directory:

Note: When you import the TIFF image, ER Mapper will extract the georeferencing 
information from the associated TFW file if a .ers header file does not exist. Yo
would then have to use the ER Mapper Change Projection/Datum/Cell Size 
Wizard to add the datum and projection information, as explained in Chapter 
“Using GeoTIFF/TFW images”.

Open the TIFF import dialog
1 From the Utilities menu, select Import Graphics formats , then select 

Raster Translated Images , then Import .

1_3_rect.tif The image data file.

1_3_rect.tfw The “world” TFW header file originally supplied with the 
TIFF image file. This is a text file that contains 
georeferencing information, but does not include the datum 
projection of the image.

1_3_rect.ers An ER Mapper header file created by the Change 
Projection/Datum/Cell Size Wizard in the exercise in 
Chapter 3, “Using GeoTIFF/TFW images”. This header file 
does include the image datum and projection, and will be 
used by ER Mapper rather than the TFW file. 
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The Import Raster_Translated dialog box opens. This dialog lets you specify
the name of the input file to be imported, and the name of the ER Mapper data
be created. All image formats that can be opened directly in ER Mapper are 
imported via this dialog box.

2 Click the file chooser  button on the right side of the Import File/Device 
Name field.

The Input File Selection  dialog box opens.

3 In the Files of Type:  field, select ‘GeoTIFF/TIFF(.tif)’.

4 From the Directories  menu (on the Input File dialog), select the path 
ending with \examples . 

5 Double-click on the directory named ‘functions_and_features’ and then 
‘airphoto_tutorial’ to open it.

6 Double-click on the image file named ‘1_3_rect.tif’ to load it.

7 Click the file chooser  button next to the Output Dataset Name  field.

The Output Dataset Selection  dialog box opens.

8 From the Directories  menu (on the Output Dataset dialog), select the path 
ending with \examples . 

9 Double-click on the directory named ‘Miscellaneous’ followed by ‘Tutorial’

10 In the Save As:  field, enter the text imported_airphoto then click OK.

11 Click OK on the Import TIFF  dialog.

ER Mapper reads the TIFF file and begins creating a dataset in ER Mapper fo

12 When the import finishes, click OK on the confirmation dialog, then click 
Cancel on the Import Raster_Translated  dialog.

In this case, ER Mapper translated the TIFF image data and created two files

• ‘imported_airphoto’ (the binary data file)

• ‘imported_airphoto.ers’ (the ASCII header file)
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2: Reproject the image

Open the Geocoding WIzard

1 Click on the Ortho and Geocoding Wizard   button in the Common 
Functions  toolbar.

The Geocoding Wizard will open with the 1) Start  tab selected.

2 Click the Load Algorithm or Dataset  button in the Input file:  field to 
open the file chooser. 

3 From the Directories  menu, select the path ending with the text \examples .

4 Select the directory ‘Miscellaneous\Tutorial’ and then double-click on 
‘imported_airphoto.ers’ to select it.

This is the image that you imported earlier.

5 Select the Geocoding Wizard Map to map reprojection option.

6 Select the 2)Map to Map Setup  tab.

Objectives Learn how to change the image datum and projection.
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Map to Map setup
The Geocoding Wizard Map to Map Setup page displays the datum and proje
of the input image, and allows you to enter new settings to which the image ca
reprojected.

In this example you are going to change the UTM type projection, ‘NUTM11’ t
State Plane Lambert Conformal Conic (lamcon2) type projection, ‘L2CAL6F83
This is ‘NAD83’ datum zone 6 in feet. State Plane projection projections are 
bounded by county borders, so the choice of projection depends on the count
covered by the image. 

The State Plane System was developed in the 1930s and was originally base
the North American Datum 1927 (NAD27). While the NAD27 State Plane Sys
has been superseded by the NAD83 System, maps in NAD27 coordinates are
in use.
ER Mapper Airphoto Mosaic Tutorial 97



Chapter 5 Reprojecting images ● 2: Reproject the image

ou to 
1 Click on the Projection field chooser  button to open the Projection 
Chooser dialog box .

2 From the left-hand projection type list, select ‘lamcon2’.

3 From the right-hand projection list, double click on ‘L2CAL6F83’ to select it 
and close the Projection Chooser  dialog box.

4 Click on the 3) Rectify  tab to go to the final wizard page.

Rectify the image
The Geocoding Wizard Rectify page allows you to enter the file name for the 
reprojected image. It also displays information about the image and enables y
change the extents and cell size.
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1 Click the file chooser  button in the Output Info  box.

2 From the Directories  menu, select the path ending with \examples . 

3 Double-click on the ‘Miscellaneous/Tutorial’ directory to open it.

4 Enter the filename ‘imported_airphoto_reproj ’ , then click OK.

You should notice that the reprojected file size is 107.75 MB, which is 
approximately the same size as the original image. This is usually a good indi
that the new projection is compatible with the original.

To speed up this exercise, you will reduce the output file size by resampling th
image to have larger cell sizes; i.e. lower resolution. This will result in a degra
image, which would not be suitable for all applications. 

5 In the Cell Attributes  box, edit the Cell size X  and Cell Size Y  values to 
both be 0.12 meters. Press the Enter  button to confirm the changes.

The output file size should now be 26.75 MB, which is approximately 25% of t
original size.

6 Leave the Null cell value  box unchecked, so that the reprojected image 
has the same null value as the original image.

The null cell value is the value that the cell must have for ER Mapper to interp
as a null cell (i.e. transparent). This is normally 0. The Geocoding Wizard gives
the option of leaving the null cell value to be that of original image (if one exist
or entering a new value.

7 Select the Display rectified image  option, and click on the Save File and 
Start Rectification  button.

This will save the reprojection information in the .ers header file of the original
image, and start the wizard creating the new reprojected image.

ER Mapper displays a status box that indicates the progress of the reprojection
indicates successful completion.

8 Click OK to close the completion dialog box.

ER Mapper will display the reprojected image, ‘imported_airphoto_reproj’, in a
image window.

9 Click on the Geocoding Wizard dialog Close  button to exit the wizard.
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Close all windows
1 Close all image windows using the window system controls:

2 Click Close  on the Algorithm  window to close it.

Only the ER Mapper main menu should be open on the screen.

• Import a Tiff image in ER Mapper

• Change the image project from a UTM to a State plane projection.

• Resample the reprojected image to have larger cell sizes.

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Assembling
image mosaics

This chapter explains how to create algorithms to display and process two or 
separate airphoto images as a mosaic. You will learn how ER Mapper approa
the concept of creating mosaics and how to build an image mosaic algorithm.

About assembling mosaics
The term “mosaic” refers to assembling two or more overlapping images to cre
continuous representation of the area covered by the images (a mosaic). In th
example, you will create a mosaic of several overlapping aerial photos to cove
larger geographic area. The process of creating image mosaics is very simple
ER Mapper once the images are rectified to the same datum and map project
Any number of co-registered images used in the same processing algorithm a
automatically displayed in their correct geographic positions relative to each o

Requirements for mosaics
In order for ER Mapper to create a mosaic, each of the images must have the
following in common:

• they must be registered to the same geographic datum 

• they must be registered to the same map projection 
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• they must be rotated the same amount from north (if rotation is used). 

You will learn how to rectify images to datums and map projections later. 

Mosaic capabilities 
Other than having a common datum and map projection, you can create mosa
that contain very different types of data. An image mosaic can be built with data
that have:

• different numbers of bands (i.e., three for a color airphoto versus seven for a La
satellite image)

• different data formats (i.e., byte format versus floating point format) 

• different resolutions or cell sizes (i.e., 1-meter versus 3-meter). 

Image display priority
By changing the order of the algorithm layers containing the separate images
can control image display priority (that is, which images appear on top of othe
the event of overlap). Images loaded into the uppermost layer of any type alw
appear on top of any other images in layers below where overlap occurs betw
them. 

Images loaded into the lowest layer of any type always have the lowest displa
priority and will only be visible in areas where there is no overlap from datase
layers above them. For example, if you are creating a mosaic with a high resol
dataset and a lower resolution image, you can display the entire extents of the
resolution image by putting its layer(s) on top in the algorithm layer list.

Note: Layer priority only applies to raster layers; vector layers always appear on top
raster layers regardless of their position in the algorithm layer list.

Hands-on exercises
These exercises show you how to create greyscale and RGB image mosaic 
algorithms.

The ER Mapper Image Display and Mosaic Wizard  provides the easiest and 
most efficient way of mosaicing images, and should be used where possible.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:
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• Use the Image Display and Mosaic Wizard to speed creation of greyscale and
mosaics

1: Creating mosaics automatically

Start the Image Display and Mosaic wizard
1 On the Common Functions  toolbar, click the Image Display and Mosaic 

Wizard  button.

The Select files to display and mosaic  page of the Image Display and 
Mosaicing Wizard opens

2 Click the Load Image   button.

The Select File dialog opens.

3 From the Directories  menu (on the Select File dialog), select the 
\examples  path. 

4 Double_click on the ‘Functions_and_Features’ directory to open it.

5 Double_click on the ‘airphoto_tutorial’ directory.

6 Double-click on the image dataset ‘1_4_rect.ecw’ to select it.

This is a 1GB high resolution airphoto of San Diego that has been orthorectifie
and compressed with ER Mapper ECW compression. 

Tip: You can save disk space by compressing the individual images before mosaic
them. 

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to speed the creation of greyscale and RGB mosaic algorithms usi
the Image Display and Mosaic Wizard.
ER Mapper Airphoto Mosaic Tutorial 103



Chapter 6 Assembling image mosaics ● 1: Creating mosaics automatically

that 
7 Select the following options on the wizard page:

8 Click on the Next>  button to go to the next wizard page.

Select file types to mosaic
This page allows you to specify the characteristics and location of image files 
the wizard must search for to mosaic with the image already selected. 

1 Select the Cell sizes  and Manually set mosaic properties  options. Do not 
select the other options on the page. 

Display image in 2D Image will be displayed in a 2D mode.

Manually set display 
method

Enables you to set how the image is to be 
displayed. If you do not select this option, the 
wizard will set the display method.

Mosaic all files of this 
type

The wizard will search for files of the same type 
and automatically mosaic them.

Manually set mosaic 
method

Enables you to set how the images are to be 
mosaiced. If you do not select this option, the 
wizard will set the mosaicing
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This tells the wizard that the images to be mosaiced must all have the same d
types and number of bands, but can have different cell sizes. They are also in
same directory.

2 Click on the Next>  button to go to the next wizard page.

Select mosaic properties
This page allows you to specify properties of the mosaiced image. 

1 Select the Feather blend mosaic between images  options. Do not select 
the other two options.

It is not necessary to define and use stitch regions here. You will see later tha
Image Balancing Wizard does this automatically.

2 Click on the Next>  button to go to the next wizard page.

Select display method
This page allows you to specify how you want the mosaiced image to be displa

1 Select the Greyscale  display option and Manually select display method  
properties.

2 Click on the Next>  button to go to the next wizard page.

Select display band
This page allows you to select the image band to display as a greyscale. 
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1 Select band ‘B1:Red’ from the drop-down menu. 

This specifies that the Red band of the image is to be displayed as Greyscale

2 Click on the Next>  button to go to the next wizard page.

Mosaic and display the images
The wizard searches the current directory and mosaics and displays the follow
images:

• 1_4_rect.ecw

• 1_5_rect.ecw

• 2_6_rect.ecw

• 2_7_rect.ecw

1 For the moment, leave the Image wizard has finished  page open.

2 Drag the lower border of the image window downward about 50%.

3 Right-click in the image window, select Quick Zoom, then Zoom to All 
Datasets .

ER Mapper zooms out to show the full extents of all four airphoto images. 

4 On the main menu, click the Edit Algorithm  button.

The Algorithm  dialog box opens.
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You now have a algorithm that displays band 1 of each dataset as a greyscale
mosaic.

5 If necessary, use the Move Up  and Move Down   buttons to 
arrange the layers so that they are as shown in the diagram above.

Turn the top image on and off 
1 Right-click on the top ‘Pseudo Layer’ and select Turn Off .

Only the top right, bottom left and bottom right images display (since the top l
image is turned off).

2 Right-click on the top ‘Pseudo Layer’ and select Turn On .

The top left image redisplays in its appropriate geographic position again. Any
images in a mosaic can be displayed or not displayed by turning their layers o
off.

Zoom in to the geographic extents of any image dataset
1 Widen the image window

2 Select the top ‘Pseudo Layer’ (‘1_4_rect.ecw’) in the algorithm.

3 Right-click in the image window, select Quick Zoom, then Zoom to 
Current Dataset .

ER Mapper zooms in to the full extents of the ‘1_4_rect.ecw’ dataset (but also 
displays part of the lower dataset that occupies the same extents).
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Zoom to Current Dataset  lets you instantly zoom in or out to the extents of an
raster image dataset(s) in the currently selected layer, so it is very useful for m
algorithms.

4 Right-click in the image window again, and select Zoom to All Datasets  
from the Quick Zoom  menu.

ER Mapper zooms out to display the full extents of the mosaiced image.

2: Creating an RGB image mosaic

We use the Image Display and Mosaicing wizard to re-display the existing 
greyscale mosaiced image as an RGB image.

Change the image display method
1 On the Image wizard has finished  wizard page, which should still be open, 

click on the Back to Change display method  button.

This will return you to the Select display method wizard page.

2 On the Select display method  page, select the Red Green Blue  option.

3 Click on the Next>  button to go to the next wizard page.

4 Select RGB 123 as the Red Green Blue display mode type. 

Objectives Learn how display several overlapping images in different sets of red, green, a
blue raster layers to create an RGB image mosaic. 
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This option allocates band 1 to Red. band 2 to Green and Band 3 to Blue.

5 Click on the Next>  button to mosaic and display the images, and to go to 
the final wizard page.

The wizard will now display the mosaiced image in RGB mode.

6 Leave the Image wizard has finished  wizard page open for the moment.

Tip: In RGB mosaic algorithms, each group of red, green and blue layers act togeth
a set. Therefore, you normally want to keep them grouped together in the laye
in the Algorithm  dialog. (To see which dataset is loaded into a particular layer
select the layer–the name is shown above the process diagram.)

3: Adding a GeoTIFF image to the mosaic

We use the Image Display and Mosaicing wizard to add a GeoTIFF image to 
mosaic.

Add an extra image to the mosaic
The ‘airphoto_tutorial’ directory contains the image file that you saved in GeoT
format in a previous exercise. The Display and Mosaic Wizard did not 
automatically include it in the mosaic because it is in a different format to the o
image files. You can, however manually add it to the mosaic.

Tip: This procedure is included to demonstrate that it is possible to mosaic images
different file formats. In this case it would have been better to have compresse
GeoTIFF image with ECW v2 first, and then have let the wizard automatically 
include it in the mosaic with the other ECW v2 compressed images.

Objectives Learn how to add an additional image to the mosaic. 
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1 On the wizard dialog, select the Back to Change file  button.

The wizard will go back to the file input page.

2 Click on the <Back  button to go back one page.

3 Select the Add more to this window  option, and then click on the Next>  
button.

4 On the Select files to add to display  wizard page, click on the file chooser 
button.

5 In the ‘airphoto_tutorial’ directory, double-click on the ‘1_3_rect_geo.tif’ file 
to select it.

6 Make sure that only the Manually set display method  option is selected 
before clicking on the Next>  button.
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The wizard will add the ‘1_3_rect.tif’ image to the mosaic, and automatically s
the display mode to Red Green Blue .

7 Click on wizard Finish  button to close it.

Save the mosaic algorithm to disk
1 From the File  menu (on the main menu), select Save As... .

The Save As...  file chooser dialog opens.

2 In the Files of Type:  field, select ‘ER Mapper Algorithm (.alg)’

3 From the Directories  menu (on the Open dialog), select the path ending 
with \examples . 

4 Open the ‘functions_and_features\airphoto_training’ directory.

5 In the Save As:  text field, type the following filename:

airphoto_mosaic

This name denotes that it is a mosaic of airphotos.

6 Click OK to save the algorithm.

Your mosaic algorithm is now saved to an algorithm file on disk. 

Added GeoTIFF image
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Close all image windows and dialog boxes
1 Close both image windows by selecting Close  from the File  menu.

2 Click Close  on the Algorithm  dialog to close it.

Only the ER Mapper main menu should be open on the screen.

• Use the Image Display and Mosaic Wizard to speed creation of greyscale and
mosaics

• Turn images on or off in a mosaic

• Add images to mosaics

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Color balancing
image mosaics

This chapter explains how you use the ER Mapper Image Balancing Wizard for 
Airphotos to balance and color match airphoto mosaics.

Hands-on exercises
These exercises show you how to balance and color match mosaic algorithms
the Image Balancing Wizard for Airphotos .

For these exercises, we will be using the airphoto mosaic algorithm we create
previously using the Image Display and Mosaic Wizard .

• Use the Image Balancing Wizard to balance and color match an airphoto mos

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen. 
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1: Color balancing the mosaic

Open the airphoto mosaic

1 On the main menu, click the Open  button.

2 From the Directories  menu, select the \examples  path.

3 Open the ‘functions_and_features\airphoto_tutorial’ directory.

4 Double-click on the algorithm ’airphoto_mosaic.alg’ to open it.

This is the algorithm that you saved in the previous exercise. It comprises one
GeoTIFF and four ECW compressed airphotos of San Diego that were mosai
using the Image Display and Mosaic Wizard .

Objectives Learn how to use the Color Balancing Wizard for Airphotos  to color 
balance mosaiced images so that they interface seamlessly with one another.

click to open
algorithm
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Open the Image Balancing Wizard for Airphotos

1 Click on the Image Balancing Wizard for Airphotos   button on the 
Common Functions  toolbar to open the wizard.

The wizard processes the currently active image window

2 Select the Images have changed and need reanalyzing  option.

The wizard has to analyze the images the first time it is used on them, and sk
over it if the images have been previously analyzed. Selecting this option force
wizard to analyze the images regardless of whether this has been done befor

3 Click on the Next>  button to go to the next wizard page.

Analyze images for balancing
The wizard requires the images to be analyzed before it can do the balancing
analysis information is stored in the image dataset header files. If the images 
not yet been analyzed or you selected the reanalyzing option, the wizard will n
do so. 

1 Click on the Next>  button for the wizard to analyze the images.

The wizard will calculate the statistics for the four images and write the 
information into their respective header files.

Note: ER Mapper creates header (.ers) files for the images to store the analysis 
information if they do not already exist. 

2 Click on the Next>  button to go to the next wizard page.
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Select how to balance the images
In addition to color balancing, you also have a number of options for displaying
image. These are described below:

Original Remove any color balancing and display 
the unbalanced images.
The white boxes in the diagram show the 
extents of the individual images with their 
black edges removed.

Balanced Display the balanced images but do not 
clip edges.

Balanced 
with no 
black/
white 
edges

Display the balanced images and remove 
the black or white edges. 
It is preferable not to select this option 
when balancing images that have very 
dark water, near the edges of the image. 
The color balancing wizard for airphotos 
may select too much of the image as dark 
edges to be removed. 
Note: Some images are supplied with 
their black edges already removed, in 
which case it is not necessary to select 
this option.

Balanced 
with clip 
regions

When mosaicing images, compute clip 
regions to hide the edges between images. 
Clip regions are areas of overlap that are 
trimmed off to create a seamless join. The 
wizard re-computes the clip regions every 
time you run it.
By default, the wizard turns feathering 
ON for when balancing with clip regions, 
and OFF in all other cases.
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1 Select the Balanced with clip regions  option.

2 Do not select the Correct for water areas  because the image does not 
have large areas of water.

3 Select ‘None’ in the Blue Haze Filter  field.

The Image Balancing Wizard uses this field for handling effects caused by hav
“blue haze” filter on the camera lens at data capture time.

4 Click on the Next>  button for the wizard to balance the images and go to 
the Color matching page.

The wizard will create the clip regions and then balance the image. It will then
display it in the image display window as the temp-balance algorithm.

Color matching the image
To create a seamless mosaic, the wizard is able to match the colors of the mo
image to the whole mosaiced image or to one of the images that are part of th
mosaic. Alternatively you can skip the color matching altogether. 

For this exercise we will match the color to the ‘1_3_rect_geo.tif’ image.

Correct 
for water 
areas.

If your image has large areas with low 
contrast, such as water, they could be 
discolored by the balancing process. 
Select this option to prevent this 
happening.
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1 Select the Match colors to individual file option, and then click on the 
Next  button.

2 Use the file chooser button to select the image to which the colors are being 
matched. In this case we will select ‘1_3_rect_geo.tif’. 

3 Select the Apply 99% clip  option to improve the contrast, and click on the 
Next  button.

Caution: Generally you would not select the Apply 99% clip option if you are going to 
compress the image, because you usually want the compressed image to be 
same as the original.

The wizard will display the status of the color matching which could take some
time to finish. It will then display the final balanced and matched image in 
temporary algorithm.

4 Click on the Finish  button to exit the Color Balancing Wizard for Airphotos.

View the algorithm

1 On the main menu, click the Edit Algorithm  button.

The Algorithm  dialog box opens.

You now have a algorithm that displays the Red, Green and Blue layers of the
images.

2 Select the top Red layer and click on the Edit Formula   button on the 
process diagram.

This will open the Formula Editor .
118 ER Mapper Airphoto Mosaic Tutorial



Chapter 7 Color balancing image mosaics ● 1: Color balancing the mosaic

 that 
ide 
You should notice that the wizard has applied a formula to the layer. This is 
displayed in the text box at the bottom of the Formula Editor  dialog box.

The formula applies a balancing function, ‘balance()’, to the areas of the image
fall within the automatically created clip region, ‘Image Clip’. Raster cells outs
the clip region are converted to nulls.

3 On the Formula Editor  dialog , click on the Red button to view the formula 
for the next red layer.

Note that the formula applied is the same as that for the top red layer. 

4 Click three times more on the Red button, to move to the three lower red 
layers. 

Not that, in all cases, the formula applied is the same.

5 Repeat the above steps for the Green and Blue layers by clicking on the 
Green and Blue buttons respectively.

6 Click on the Close button to exit the Formula Editor .

7 Once again select the top Red layer, and click on the Edit Transform 

Limits  button on the right side of the Process Diagram.

This will open the Transform  dialog box. 

8 View the histograms and transforms of all the Red layers by clicking on the 

Red  button.

Red button

Green button 

Blue  button 
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A histogram is a plot showing the range of pixel values on the X-axis against t
relative frequency on the Y-axis.

The transform line maps the data values on the X-axis to the display brightnes
the Y-axis. The Y-axis values will always be 0 to 255, but the X-axis values dep
on the image data. The X-axis values in our example image are from 0 to 255
linear transform line will create an output histogram that is the same as the in
You can alter this line to create different output histogram, which is shown as 
separate unfilled graph.

To match the colors, the wizard has changed the transform lines so that the o
histograms for each layer are the same. 
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The following histograms of two of the layers illustrates this.

Balanced

Unbalanced

Output histograms similar

Color matched

Layer 4 Layer 5

Layer 4

Layer 4

Layer 5

Layer 5
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9 Repeat the above for the Green and Blue layers.

In all cases note how the wizard has matched the histograms for the five image
make up the mosaic.

Save the balanced algorithm to disk
1 From the File  menu (on the main menu), select Save As... .

The Save Algorithm  file chooser dialog opens.

2 From the Directories  menu, select the path ending with the text \examples .

3 Open the ‘functions_and_features\airphoto_tutorial’ directory. 

4 In the Save As:  text field, type the following filename:

 airphoto_mosaic_balanced.alg

This name denotes that it contains a balanced mosaic of the airphoto images

5 Click OK to save the algorithm.

Your balanced algorithm is now saved to an algorithm file on disk.

Note: At this stage, the only disk space being used is that to store the original one 
GeoTIFF and four compressed images. It is now possible to save the balance
mosaic in any image format, including ECW compressed.

Close the image window and Algorithm dialog
1 On the main menu, select Close  from the File  menu to close the image 

window.

2 Click Close  on the Algorithm  dialog.

Only the ER Mapper main menu should be open on the screen.

• Use the Color Balancing Wizard for Airphotos to balance and color match the
mosaiced images.

• Open the Formula Editor to view the formula that the wizard applies to the lay

• Open the Transform dialog to view the histograms and transforms.

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Compressing
images

This chapter shows you how to save your large mosaic as a compressed imag

About Enhanced Compression Wavelet 
(ECW) compression

ER Mapper compresses images using wavelet compression technology that o
very high quality results at high compression rates.  You can typically compres
color image to less than 2% to 5% of its original size (50:1 to 20:1 compressio
ratio) and compress a grayscale image to less than 5% to 10% of its original s
(20:1 to 10:1 compression ratio). 

This means that, at 20:1 compression, 10GB of color imagery will compress d
to 500MB, which is small enough to fit on to a single CD-ROM. You may actua
achieve higher compression rates where your source image has a structure w
suited to compression.

In addition to reducing storage requirements, you can also use the free image
plug-ins for GIS and office applications to read the compressed imagery in a w
range of software applications such as ArcView®, AutoCAD MAP®, MapInfo®
ER Viewer, Photoshop™, Microsoft Office® and Excel®, and other software 
applications. 
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Hands-on exercises
These exercises show you how to save images in ECW compressed format u
the Compression Wizard .

For these exercises, we will be using the airphoto mosaic algorithm we create
color balanced previously.

• Use the Compression Wizard to save images in ECW compressed format.

1: Saving a compressed image to disk

Tip: The compression process could take a long time because of the large size of 
image being compressed. It is suggested that you time this exercise to allow t
compression to take place overnight. 

1 From the main ER Mapper File  menu, select Save as a Compressed 
Image .

The Compression Wizard  will open.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to save large images in compressed format using the ER Mapper E
compression.
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Input image to be compressed

1 Select the Select input image (or mosaic) to compress option as the 
source of the image(s) to be compressed and click on the Next >  button.

2 In the Input file:  field, click the Select File  button.

3 From the Directories  menu, select the \examples  path.

4 Open the ‘functions_and_features\airphoto_tutorial’ directory, then double-
click on the algorithm ‘airphoto_mosaic_balanced.alg’ to select it.

This is the image mosaic that you created earlier, and you now save it as a 
compressed image.

In addition to using an algorithm as the source image to be compressed, you 
specify any other file format supported by ER Mapper, such as ESRI BIL, TIFF
JPG as the input.

Compressed image file name

5 In the Output file:  field, click the Select File  button. 

6 From the Directories  menu, select the \examples  path.

7 In the Select File  dialog, choose ER Mapper compressed images (.ecw) in 
the Files of Type  field.

8 Open the ‘functions_and_features\airphoto_tutorial’ directory.
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9 In the Open:  text field, enter the text airphoto_mosaic_compressed 
and separate each word with an underscore (_).

10 Click OK on the Select File dialog.

Your file name appears as the Output File  name with a ‘.ecw’ extension. 

ER Mapper will save the compressed image as a header (.ers) and a compres
data (.ecw) file. You can use File / Open  or one of the wizards to open the head
(.ers) or data (.ecw) file just like any other image file supported by ER Mapper

Note: The data (.ecw) file contains embedded georeferencing information, so the he
(.ers) file can be dispensed with if the compressed image is to be used in 
applications other than ER Mapper. 

Compress to Grayscale, RGB or Multi
11 In the Compress to:  field, select the Color (RGB) option

The compression engine internally converts the RGB color image into YUV co
space, specifically the one defined as the "JPEG Digital version of YUV".  YUV
a color space that separates out intensity (Y) from chromatic or color changes
and V). This enables more efficient compression of color imagery, ensuring th
detail is preserved.  The RGB to YUV conversion (and back again for 
decompression) is automatic; the user always sees the file as a RGB file.

Other compression options available are:

Grayscale The compression engine constructs and compresses 
grayscale view of your input image data using the 
normal formula for Intensity from Red, Green and Blu

Multiband The compression engine compresses all the bands of
multi-band image. Use this option for compressing 
hyperspectral images.

12 Click on the Next >  button to continue
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13 Check the Compress for Internet  usage box.

This option is for compressed images to be served on an ER Mapper Image W
Server. The transfer rate over a network for images compressed with this opti
higher, thus allowing faster zooming and roaming. However, the actual 
compression ratio achieved will be less than that for images compressed with
this option. For more information on the Image Web Server, refer to the ER Ma
web site, http://www.earthetc.com.

14 If necessary, change the Colorscale ratio:  to 50 and click on the 
Recompute desired output size  button.

This value is the desired compression ratio that you would like to achieve.  Fo
example, you might specify a ratio of 20:1 for an input file of 1,000MB to achiev
desired a 50MB compressed image (so the output image is 5% of the size of 
input image).

The Compression Wizard uses the Target Compression ratio as a measure of
much information content to preserve in the image; i.e as a quality indicator.  
however, your image has areas that are well suited to compression, a greater 
compression may be achieved while still achieving the desired information con
The actual compression ratio could also be less than the target if you are 
compressing small files. The Compression Wizard uses multiple wavelet enco
techniques at the same time, and adapts and chooses the best technique dep
on the area currently being compressed.
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One example of this is an image that has large areas of water or desert. Thes
often be compressed with greater efficiency. Another example is a compresse
image that consists of high resolution airphotos, over lower resolution satellite
imagery where there are no airphotos. Because the satellite images  are lowe
spatial resolution, greater compression can be achieved in these areas of the 
while still preserving high quality detail in the airphoto area.

15 Click on the Finish  button to start the compression process.

Note: The compression of an image this large could take a long time to complete.

Compression process
A status dialog will display the progress of the compression. When the 
compression is complete, a dialog will display the Target and Actual compress
rates.

Except when compressing very small files (less than 2MB in size), the Actual 
compression ratio will generally be greater than the Target compression ratio.

Comparing compressed and original images

1 On the main menu, click the Open  button. 

An image window and the Open dialog box appear.

2 From the Directories  menu, select the \examples  path.

3 Open the ‘functions_and_features\airphoto_tutorial’ directory, then double-
click on the algorithm ‘airphoto_mosaic_balanced.alg’ to open it.

This is the original image map, which comprises four compressed and mosaic
airphotos.

4 Re-size the image window to make it larger.

5 Right-click on the image and, from the Quick Zoom  menu, select Zoom to 
Page Extents .
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The image will enlarge so that the map page fills the image window.

6 On the main menu, click on the New  button.

This will open a second image window.

7 On the main menu, click the Open  button. 

An image window and the Open dialog box appear.

8 In the Files of Type:  field, select ‘ER Mapper compressed images (.ecw)’.

9 From the Directories  menu, select the \examples  path.

10 Open the ‘functions_and_features\airphoto_tutorial’ directory, then double-
click on the file ‘airphoto_mosaic_compressed.ecw’ to open it.

This is the compressed image file that you have just created.

11 Re-size this new image window to make it the same size as the other.

12 Right-click on the image and, from the Quick Zoom  menu, select Zoom to 
All Datasets .

The image will enlarge to fill the image window.

13 Move the image windows so that they are next to one another.

14 Compare the quality of the two images.

The quality should be virtually identical because the original mosaic was mad
of individually compressed images. This is an example of how you could crea
mosaics with thousands of large images while conserving disk space. The ste
follow are:

1. After geocoding the images, compress them and store them on disk.

2. Use the Image Display and Mosaic Wizard to mosaic the compressed imag

3. Use the Balancing Wizard to balance and color match the mosaiced image

4. Use the Compression Wizard to compress the final image.
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Close both image windows and dialog boxes
1 Close the image window using the window system controls:

2 Click Close  on the Algorithm  dialog.

Only the ER Mapper main menu should be open on the screen

• Save the image in compressed format using the ECW compressor.

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Exporting to GIS
systems

This chapter shows you how to save all or part of a processed mosaic image f
in a GIS or desktop mapping software product.

About use in GIS systems
Once you have created your mosaic of images in ER Mapper, you may want to
all or part of the mosaic image in a format suitable for use in a GIS or Desktop
Mapping System (DMS). The procedure you will use depends upon the raster
formats your GIS can accept, and its capabilities for handling large image dat

Note: ER Mapper provides free plug-ins to most GIS or Desktop Mapping System 
applications, which allow you to open ER Mapper images directly in those 
applications. Formats supported include ER Mapper algorithms, raster datase
virtual datasets and ECW compressed images. Where possible, you are advis
use these plug-ins which are available for download at www.ermapper.com . 

Since GIS and desktop mapping systems are usually designed to handle vect
(line/polygon) data, they have limited capabilities for handling raster (image) d
For example, ER Mapper has no problem handling a 20,000 by 20,000 pixel im
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but few GIS or DMS applications can do this. When preparing to save an enha
image from ER Mapper for use in a GIS or DMS, there are three possible solu
to this problem: 

• Save the image in ECW compressed format. The high compression rates ach
by using this format make the image files significantly smaller. You can then us
applicable free plug-in to open the compressed image in the GIS application.

• Resample the image to a lower spatial resolution (cell size). This creates muc
smaller files, but you lose detail in the image. This may be best if you want to m
a single image file that covers a large geographic area.

• Subset the airphoto (or mosaic) image into a set of smaller files, each coverin
smaller geographic area. This maintains the original detail in the airphotos an
creates individual files small enough for your GIS or DMS to handle. (It still 
requires a large amount of disk space to store all the individual high resolution 

Cropping or subsetting images
Often you will want to crop or subset part of the entire mosaic that covers just
area of interest, or subset a large mosaic into smaller pieces. There are two b
steps:

• Zoom into the desired area. You can do this visually by dragging a zoom box 
the the mouse, or by entering exact coordinates in the Algorithm Geoposition 
Extents  dialog.

• Save the area of interest to an external file. You can save to an ER Mapper U
(Universal Data Format) dataset (which can be read by many systems), or to 
graphics file such as TIFF.

Spatial resolution (cell size)
Digitized aerial photos are often created at very high resolution; for example o
meter pixel size or even less. This creates very large image files that can be 
hundreds of megabytes in size. There are two reasons why you may want to 
consider reducing the spatial resolution (cell size) of the exported image:

• GIS/DMS file size limitations–If you want to use an image covering a large 
geographic area, you may need to resample the image to a lower spatial reso
(larger cell size), thus creating a smaller file that can be handled by the GIS pro

• Detail required for the project–The amount of detail in airphotos is often not 
needed for a particular application or project. For example, for updating a gen
land use database, it may not be necessary to use imagery with less than 1-m
resolution. If desired, you can resample the image to the level of detail neede
the project to create files that are only as large as necessary for the applicatio
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Raster formats for GIS and DMS products
The two most common formats accepted by GIS and DMS products are TIFF
(Tagged Image File Format) and BIL (band interleaved by line) format. 
ER Mapper’s native format is binary BIL, so that is the best solution for produc
that can read BIL format. Use the following guide to determine which format y
need to use:

• ArcView GIS® OR ARC/INFO® –Create an ER Mapper UDF (Universal Data
Format) dataset (in BIL format), which, in addition to the “.ers” header file, inclu
a “.hdr” file that allows ArcView GIS® or ARC/INFO® to read the BIL file 
directly. 

• Autodesk World™, AutoCAD MAP® or AutoCAD® –Use ER Mapper to save 
the image to a TIFF format file.

• MapInfo –Use ER Mapper to save the image to a TIFF format file. Alternativel
ER Mapper also provides a free upgrade to MapInfo users that allows MapInf
directly read ER Mapper format image files and algorithms. The link automatic
passes the map projection information to MapInfo. This allows users to integr
very large mosaics of imagery as backdrops into MapInfo quickly and easily.

• Other GIS and DMS products–Use ER Mapper to save the image to a TIFF or
other compatible graphics format file.

Using compressed images in GIS 
applications

The ECW Compression Wizard, which is included in ER Mapper, enables you
save large images in the ECW compressed format with minimal loss in quality
Compression rates can typically be in the order of 50:1.

The relatively small file sizes of ECW compressed images make them ideal fo
in GIS applications. The free plug-ins available for many GIS products allow y
to open ECW compressed images directly in those products. You can also op
ECW compressed images served over a network (e.g. the Internet) by entering
URLs. You can then roam over and zoom into the image over the network from
within the application.
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Hands-on exercises
These exercises show you how to crop an area of interest from a mosaic imag
save the area as an ER Mapper UDF dataset and a TIFF file.

• Define an exact area of interest using geographic coordinates

• Save the image as a new UDF dataset

• Resample the resolution (cell size) of a dataset

• Save an image as a TIFF format graphics file

1: Defining an area of interest

Open the final mosaic algorithm
1 On the main menu, select Open  from the File  menu.

An image window and the Open dialog appear.

2 From the Directories  menu (on the Open dialog), select the path ending 
with \examples . 

3 Open the 
‘functions_and_features\functions_and_features\airphoto_tutorial’ directory.

4 Double-click on your ‘airphoto_mosaic.balanced.alg’ algorithm to open it.

The balanced RGB mosaic image displays. Next you define a small area of in
for your project.

Zoom into the project area
Assume that you have a project to display a particular building near the cente
the mosaic image. The project calls for an image showing an exact area defin
Easting and Northings values (meters) in the UTM projection being used.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows a
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to define exact areas of interest in an image, and how to subsection an
image into smaller files.
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1 From the View  menu, select Geoposition .

The Algorithm Geoposition Extents  dialog opens.

2 Click the Extents  tab to display the current mosaic extents.

3 Enter the following values in the Eastings and Northings Top Left and 
Bottom Right fields:

Top Left - Easting: 483881

Top Left - Northing: 3622145

Bottom Right - Easting: 483921

Bottom Right - Northing: 3622105

4 Click the Apply  button.

ER Mapper zooms to the exact extents you entered. You have now defined a p
area to be exported for analysis in your GIS or DMS system.

Also notice that the area is approximately 1.2 by 1.1 kilometers in size (in the 
Eastings and Northings Size fields), and that the it displays approximately 197
985 pixels of the mosaic image.

5 Click Close  on the Algorithm Geoposition Extents  dialog.

edit values
(Enter/Return
to validate)
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2: Creating a UDF dataset

Note: You can also use the following procedure to save your entire mosaic of image
single, large ER Mapper dataset. This may be desirable if disk space is not an
because displaying and zooming a processed ER Mapper dataset is much fas
than displaying and zooming a mosaic of images that have complex formulas 
other options in the algorithm (where the processing must be executed each t
you zoom or pan).

Setup the algorithm for dataset output
Saving an image as a dataset is similar to creating an algorithm for the screen
display, except that you are sending the resulting processed image to a new d
on disk, instead to an image window on the screen.

1 On the main menu, select Algorithm from the View menu.

The Algorithm dialog opens. Note that this algorithm has red, green and blue
layers to create the RGB color image. You want your output ER Mapper datas
also have red, green and blue bands.

2 Examine the layer labels.

The layer labels you see determine what the band labels will be in the new ou
dataset. In this case, your output dataset will have three bands labelled ‘Red L
‘Green Layer’ and ‘Blue Layer.’

Note: ER Mapper merges any layers with the same label into a single band in the ou
dataset. (So if you have two or more sets of red, green and blue layers, they a
merged into single red, green and blue bands in the output dataset.) To output 
as individual bands, make sure each layer has a unique label in the algorithm

Objectives Learn to save the area of interest to a new raster dataset in UDF format, and 
to resample the image to a larger cell size (reduce the spatial resolution).

layer labels become band
labels in output dataset
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Save the project area to a full resolution UDF dataset
In this case, assume you want to maintain the full resolution of the airphoto da
when you create the output dataset. This guarantees that all the detail in the 
airphoto will be carried through to the new dataset.

1 On the main menu, select Save As... from the File menu.

The Save As... dialog opens. This dialog lets you specify the name for the new
dataset to be created, and parameters for the dataset such as data type and s
resolution.

2 In the Files of Type: field, select ‘UDF (.ers)’.

3 From the Directories  menu, select the path ending with the text \examples .

4 Open the ‘functions_and_features\airphoto_tutorial’ directory

5 In the Save As:  field, enter the filename project_area_full , then click 
OK.

This will be the filename for the new UDF dataset.

6 On the Save as UDF  dialog, click the Defaults button.

The contents of the four parameters fields on the dialog change to display the
settings and values read from the current algorithm. Notice that:

• The Output Type  field is set to ‘Multilayer’ because there are more than three
layers in the algorithm. You should change this to ‘RGB’.

• The Width  and Height  fields are set to the number of pixels displayed in the a
you defined with Geoposition  . This creates a full resolution dataset.

Note: You should always click the Defaults  button to load the values that pertain to th
current algorithm first, then you can change them as needed.

7 Make sure that the Maintain aspect ratio  and Current View  options are 
selected.

The Current View  option limits the image size to the extents currently being 
displayed in the image window.

8 Click OK.

ER Mapper creates a new output dataset on disk in the form of three files; the
image data file, with a “.bil” extension, and two header files with a “.ers” and 
“.hdr” extension respectively. This enables them to be opened in ER Mapper a
applications like ArcInfo®.

9 Click OK on the completion dialog.
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Display the new dataset in RGB
1 On the main menu, select New from the File  menu.

A new image window opens.

2 On the main menu, click the Open  button.

The Select a Dataset  dialog opens.

3 On the Open  dialog, Files of Type  field, select either ‘ER Mapper Raster 
Dataset (.ers)’ or ‘ESRI BIL and GeoSPOT (.hdr)’.

You can do this because saving an image as UDF creates the BIL data file wi
.ers and a .hdr header file. 

4 From the Directories  menu (on the Select File  dialog), select the path 
ending with the text \examples

5 Double-click on the directory named 
‘functions_and_features\airphoto_tutorial.’

6 Double-click on the dataset ‘Project_area_full.ers’ or ‘Project_area_full.hdr’ 
to load it.

Both selections will open the same image.

7 Click OK on the Open  dialog.

ER Mapper displays the entire subsetted image as an RGB algorithm. 

View information about the new dataset

1 On the Algorithm  dialog, click the Load Dataset  button.

The Raster Dataset  dialog opens, and your ‘Project_area_full’ dataset is 
highlighted (since it is the dataset currently loaded in the layer).

2 On the Raster Dataset dialog, click the Info  button.
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The Dataset Information  dialog opens showing information about the dataset

It shows the datum and projection, number of rows and columns (image 
dimensions, pixel (cell) size in meters (approximately 0.06 - meter resolution),
file size (about 1.3 Mb in this case).

3 Click Close on the Dataset Information dialog.

Save the project area to a half resolution UDF dataset
Let us assume that the full detail in the airphoto is not needed, and you would
to resample the image to approximately 0.12 - meter resolution to create a sm
file for your GIS. One way to do this is to follow the same steps as before, but
divide the default image width and height values by two to create a dataset at
the original resolution. (You may also want to do this simply to reduce the file 
when covering a large area if your GIS or DMS cannot handle very large imag

1 Activate the image window containing the original mosaic image (named 
‘airphoto_mosaic_balanced’).

The contents of the Algorithm  dialog change to show the mosaic algorithm.

2 On the main menu, select Save As... from the File menu.

The Save As... dialog opens. This dialog lets you specify the name for the new
dataset to be created, and parameters for the dataset such as data type and s
resolution.

3 In the Files of Type: field, select ‘UDF (.ers)’.

4 From the Directories  menu, select the path ending with the text \examples .

5 Double-click on the directory named ‘functions_and_features/
airphoto_tutorial.’
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6 In the Save As:  field, enter the filename project_area_half , then click 
OK.

This will be the filename for the new UDF dataset.

7 On the Save as UDF  dialog, click the Defaults button.

The contents of the four parameters fields on the dialog change to display the
settings and values read from the current algorithm.

8 Open the Output Type  field, select ‘RGB’.

As before, this tells ER Mapper to rescale the real data values into an 8-bit int
(0-255) data range in the output dataset.

9 Change the values in the Width  and Height  fields as follows (the original 
values divided by 2 and rounded up):

Cells Across (width) = 330

Cells Down (height) = 330

10 Click OK, then click Yes when asked to confirm the dataset creation.

ER Mapper creates a new half-resolution output dataset on disk.

11 Click OK on the completion dialog.

Note: When creating a new dataset with different cell sizes to the original data, 
ER Mapper resamples the original data to the new output cell size during the 
process of creating the new dataset. If the ‘Smoothing’ button is turned on in y
algorithm (as in this case), ER Mapper uses bilinear interpolation to create the
output dataset cell values. If the ‘Smoothing’ button is turned off, ER Mapper u
nearest neighbor resampling. Bilinear usually creates a nicer looking output im
so it is recommended that you turn on Smoothing in your algorithm before wri
the new dataset. (If you are creating the dataset at the original resolution, this
not matter.)

Display the half resolution dataset in RGB
1 On the main menu, select New from the File  menu.

A new image window opens.

2 On the main menu, click the Open  button.

The Select a Dataset  dialog opens.

3 On the Open  dialog, Files of Type  field, select either ‘ER Mapper Raster 
Dataset (.ers)’ or ‘ESRI BIL and GeoSPOT (.hdr)’.
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You can do this because saving an image as UDF creates the BIL data file wi
.ers and a .hdr header file. 

4 From the Directories  menu (on the Select File  dialog), select the path 
ending with the text \examples

5 Double-click on the directory named 
‘functions_and_features\airphoto_tutorial.’

6 Double-click on the dataset ‘Project_area_half.ers’ or 
‘Project_area_half.hdr’ to load it.

Both selections will open the same image.

7 Click OK on the Open.  dialog.

ER Mapper displays the subsetted and resampled image as an RGB algorithm

View information about the half resolution dataset

1 On the Algorithm  dialog, click the Load Dataset  button.

2 On the Raster Dataset dialog, click the Info  button.

It shows the number of rows and columns is half that of the other dataset 
‘Project_area_full,’ the cell size is approximately 0.12 meters, and the file size
about 326.7 KB (25% the size of the full resolution subset image).

Geolink the subset images to see the resolution difference
In order to compare the difference in detail between the full and half resolution
subset images, it is helpful to use ER Mapper’s geolinking feature to tie the tw
image windows together. That way, you can zoom to the exact same area in b
windows and see how the different cell sizes affect detail in the data.

Make sure the newest image window (containing the ‘Project_area_half’ datas
active (it should be by default).

1 On the Algorithm  dialog, turn off the ‘Smoothing’ option.

Turning off smoothing will allow you to see individual pixels when you zoom in 
a small area later (smoothing would integrate and smooth out pixels).

2 Right-click in the image window, select Quick Zoom , then select Set 
Geolink to Window .

The window title bar shows that the window is set to “WINDOW geolink” mode

3 Activate the other image window containing the ‘Project_area_full’ dataset.

4 On the Algorithm  dialog, turn off the ‘Smoothing’ option.
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5 Right-click in the image window, select Quick Zoom , then select Set 
Geolink to Window .

The window title bar shows that the window is also set to “WINDOW geolink” 
mode.

6 Drag a zoom box in one of the windows to zoom on a very small area.

The two windows zoom to the same area automatically, and you should be ab
see individual pixels in the two images. (Zoom in some more if you cannot.) 

Notice difference in detail between the two images–this is the effect of resamp
to a larger cell size. So, in exchange for creating a much smaller file, you mus
reduce the level of detail in the image.

Note: Geolinking images is a very useful feature for analyzing different images or th
same image in different ways or zoom levels. You can also set these options u
the Geolink  tab on the Algorithm Geoposition Extents  dialog. See the 
ER Mapper Tutorial manual for examples of the different geolink modes, and th
User Guide for more information.

7 If desired, pan to other areas in both images by clicking – both images will 
pan to the same area because they are geolinked in Window mode.

8 Click Close  on the Algorithm  dialog (you do not need it anymore).

Resampling to an exact cell size
You can also resample an ER Mapper dataset to any desired cell size. This ma
more intuitive way to resample an image by selecting a cell size rather than us
image dimensions as in the previous procedure. However, this technique requ
an ER Mapper dataset as input (you cannot use an algorithm as in the previou
procedure). To do this:

• Select Process/Geocoding Wizard .

• On the Geocoding Wizard Start  page, load the dataset to be resampled (.ers file
and select Rotation , then click on the Rotation Setup tab. 

• On the Rotation Setup  page, enter 0 for the Rotation angle , then click on the 
Rectify  tab.

A rotation angle of 0 ensures that the image is resampled without being rotate

• On the Rectify  page, enter the desired cell size (in meters) in the Cell size X  and 
Cell size Y  fields. 

• In the File  field, enter the file name of the resampled image.
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• If you want to save only a portion of the entire image, first determine the desir
upper-left and lower-right coordinates. Then click Extents  on the Rectify  page 
and enter the desired extents on the Geocode Output Extents  dialog.

• The dimensions and output file size for the resampled dataset at the cell size 
entered are displayed in Output Info  box.

• Select ‘Bilinear’ for Resampling . 

• Click on the Save File and Start Rectification button to create the new 
resampled output dataset.

3: Creating a “.hdr” file for ESRI products

The ESRI products ArcView GIS® and ARC/INFO® can read image files store
binary BIL format, which is also ER Mapper’s internal raster format. If you alrea
have a ER Mapper dataset, you can simply have ER Mapper create a “.hdr” fil
the dataset so the same image can be read by directly by ESRI products (with
creating a new dataset). If you have saved the image in UDF format, as in the
previous exercises, ER Mapper has already created the “.hdr” file so you need
do anything else. You can also use the ER Mapper export facilities to create th
“.hdr” file for a ER Mapper Raster Dataset. This exercise demonstrates how y
would do this.

Close the half resolution subset image window
1 Close the image window containing the half resolution subset image. 

(Leave the two other windows open.)

Zoom out on the full resolution subset image
1 If needed, activate the window containing the full resolution subset image.

2 Right-click in the image window, select Quick Zoom , then select Zoom to 
All Datasets .

The image zooms out to the full extents of the subsetted project area. (This is
strictly needed, but helps to simply the following concepts.)

Create the “.hdr” file for the ER Mapper dataset
1 From the Utilities  menu, select Export Raster , then ARC/INFO BIL Image 

(.hdr) , then Export .

Objectives Learn to create a header (.hdr) file for the full resolution ER Mapper dataset s
can be read directly by ESRI products.
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The ER Mapper raster file to make ARC/INFO compatible  dialog opens.

2 Click the  button next to the File  field.

3 From the Directories  menu (on the Select File  dialog), select the path 
ending with the text \examples .

4 Double-click on the directory named 
‘functions_and_features\airphoto_tutorial.’

5 Double-click on the dataset ‘Project_area_full.ers’ to load it.

6 Turn on the Verbose Messages option.

7 Click OK to start the export process.

ER Mapper displays messages about the export process, including the datum
projection, cell size and registration coordinate encoded in the “.hdr” file. 

The ARC/INFO BIL Image export utility does three things:

• Renames the ER Mapper binary data file to add a “.bil” file extension (so ESR
products recognize it as a BIL format image). In this case, the original 
‘Project_area_full’ dataset is renamed to ‘Project_area_full.bil.’

• Creates a corresponding “.hdr” file for the binary data file (‘Project_area_full.hd
This ASCII header file provides the projection, cell size and parameters neede
register the image when it is loaded into ArcView or ARC/INFO.

• Changes the “source file” reference in the ER Mapper header (.ers) file from 
‘Project_area_full’ (the previous filename) to ‘Project_area_full.bil.’ This lets y
load and use the dataset in ER Mapper just as you did before.

8 Click Close on the Batch Engine Output  dialog to close it.

Close the subset image window
1 Close the subset image window image window containing the full resolution 

subset image

You now have now transformed an ER Mapper dataset into an ESRI-compatib
dataset (without actually creating a new image file, only an ASCII header file.)

Note: The above procedure is useful if you already have an ER Mapper Raster Data
and you simply want to create an additional “.hdr” file for it. If you were saving 
image from an algorithm, it would be quicker to save it as ‘UDF’ or ‘ESRI BIL a
GeoSPOT (.hdr)’ type file.
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4: Saving a subset image to a TIFF file

The original ‘airphoto_mosaic_balanced’ algorithm should be open on the scr
If you closed it, open it again using File/Open .

Zoom into the project area
For this example, assume that the project calls for an image showing part of t
airport in the lower left corner of the full mosaic image. Again you will define th
exact project area using Easting and Northings values in the UTM projection 
system.

1 From the View  menu, select Geoposition .

The Algorithm Geoposition Extents  dialog opens.

2 Click the Extents  tab to display the current mosaic extents.

3 Enter the following values in the Eastings and Northings Top Left and 
Bottom Right fields:

Top Left - Easting: 483350

Top Left - Northing: 3621735

Bottom Right - Easting: 483534

Bottom Right - Northing: 3621565

4 Click the Apply  button.

ER Mapper zooms to the exact extents you entered, and shows part of the air
area. This is the image you will save to a TIFF file. The area displayed is 184 
170 meters in size (in the Eastings and Northings Size fields), and 3057 by 28
pixels of the mosaic image (the Cell X and Cell Y Size fields).

5 Click Close  on the Algorithm Geoposition Extents  dialog.

Save the project area to a true color (24-bit) TIFF file
In this case, assume you want to maintain the full resolution of the airphoto da
when you create the output dataset. This guarantees that all the detail in the 
airphoto will be carried through to the new dataset.

1 On the main menu, select Save As... from the File menu.

Objectives Learn to save a portion of the airphoto mosaic to a TIFF graphics file. This file
format can be read by most GIS and DMS products.
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The Save As... dialog opens. This dialog lets you specify the name for the new
dataset to be created, and parameters for the dataset such as data type and s
resolution.

2 In the Files of Type: field, select ‘GeoTIFF/TIFF (.tif)’.

3 From the Directories  menu, select the path ending with the text \examples .

4 Double-click on the directory named 
‘functions_and_features\airphoto_tutorial.’

5 In the Save As:  field, enter the filename project_area_full , then click 
OK.

This will be the filename for the new tif file.

6 On the Save as GeoTIFF/TIFF  dialog, click the Defaults button.

The contents of the four parameters fields on the dialog change to display the
settings and values read from the current algorithm. Notice that:

• The Output Type  field is set to ‘’RGB’, indicating that it will be saved as a true
color image.

• The Width  and Height  fields are set to the number of pixels displayed in the a
you defined with Geoposition  (3067 by 2833). This creates a full resolution 
dataset.

Note: You should always click the Defaults  button to load the values that pertain to th
current algorithm first, then you can change them as needed.

7 Make sure that the Maintain aspect ratio  and Current View  options are 
selected.

The Current View  option limits the image size to the extents currently being 
displayed in the image window.

8 Click OK.

ER Mapper creates a new output dataset on disk.

9 Click OK on the completion dialog.

Display the new dataset in RGB
1 On the main menu, select New from the File  menu.

A new image window opens.

2 On the main menu, click the Open  button.

The Select a Dataset  dialog opens.
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3 On the Open  dialog, Files of Type  field, select ‘GeoTIFF/TIFF (.tif)’.

4 From the Directories  menu (on the Select File  dialog), select the path 
ending with the text \examples

5 Double-click on the directory named 
‘functions_and_features\airphoto_tutorial.’

6 Double-click on the dataset ‘Project_area_full.tif’.

7 Click OK on the Open  dialog.

ER Mapper displays the entire subsetted image as an RGB algorithm. 

View information about the new dataset

1 On the Algorithm  dialog, click the Load Dataset  button.

The Raster Dataset  dialog opens, and your ‘Project_area_full’ dataset is 
highlighted (since it is the dataset currently loaded in the layer).

2 On the Raster Dataset dialog, click the Info  button.

The Dataset Information  dialog opens showing information about the dataset

It shows the datum and projection, number of rows and columns (image 
dimensions, pixel (cell) size in meters (approximately 0.06 - meter resolution),
file size (about 25 Mb in this case).

3 Click Close on the Dataset Information dialog.

Save the project area to a half resolution ER Mapper dataset
Let us assume that the full detail in the airphoto is not needed, and you would
to resample the image to approximately two-meter resolution to create a smal
file for your GIS. One way to do this is to follow the same steps as before, but
divide the default image width and height values by two to create a dataset at
the original resolution. (You may also want to do this simply to reduce the file 
when covering a large area if your GIS or DMS cannot handle very large imag

1 Activate the image window containing the original mosaic image (named 
‘airphoto_mosaic_balanced’).

The contents of the Algorithm  dialog change to show the mosaic algorithm.

2 On the main menu, select Save As... from the File menu.

The Save As... dialog opens. This dialog lets you specify the name for the new
dataset to be created, and parameters for the dataset such as data type and s
resolution.

3 In the Files of Type: field, select ‘GeoTIFF/TIFF (.tif)’.
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4 From the Directories  menu, select the path ending with the text \examples .

5 Double-click on the directory named 
‘functions_and_features\airphoto_tutorial.’

6 In the Save As:  field, enter the filename project_area_half , then click 
OK.

This will be the filename for the new tiff dataset.

7 On the Save as GeoTIFF/TIFF (.tif) dialog, click the Defaults button.

The contents of the four parameters fields on the dialog change to display the
settings and values read from the current algorithm.

8 Open the Output Type  field, select ‘RGB’.

As before, this tells ER Mapper save the image as a real color tiff file.

9 Change the values in the Width  and Height  fields as follows (the original 
values divided by 2 and rounded up):

Cells Across (width) = 1533

Cells Down (height) = 1416

10 Click OK, then click Yes when asked to confirm the dataset creation.

ER Mapper creates a new half-resolution output dataset on disk.

11 Click OK on the completion dialog.

Note: When creating a new dataset with different cell sizes to the original data, 
ER Mapper resamples the original data to the new output cell size during the 
process of creating the new dataset. If the ‘Smoothing’ button is turned on in y
algorithm (as in this case), ER Mapper uses bilinear interpolation to create the
output dataset cell values. If the ‘Smoothing’ button is turned off, ER Mapper u
nearest neighbor resampling. Bilinear usually creates a nicer looking output im
so it is recommended that you turn on Smoothing in your algorithm before wri
the new dataset. (If you are creating the dataset at the original resolution, this
not matter.)

Display the half resolution dataset in RGB
1 On the main menu, select New from the File  menu.

A new image window opens.

2 On the main menu, click the Open  button.

The Select a Dataset  dialog opens.
148 ER Mapper Airphoto Mosaic Tutorial



Chapter 9 Exporting to GIS systems ● 4: Saving a subset image to a TIFF file

. 

 is 

 in 
3 On the Open  dialog, Files of Type  field, select ‘GeoTIFF/TIFF (.tif)’.

4 From the Directories  menu (on the Select File  dialog), select the path 
ending with the text \examples

5 Double-click on the directory named 
‘functions_and_features\airphoto_tutorial.’

6 Double-click on the dataset ‘Project_area_half.tif’ to load it.

Both options will open the same image.

7 Click OK on the Open.  dialog.

ER Mapper displays the subsetted and resampled image as an RGB algorithm

View information about the half resolution dataset

1 On the Algorithm  dialog, click the Load Dataset  button.

2 On the Raster Dataset dialog, click the Info  button.

It shows the number of rows and columns is half that of the other dataset 
‘Project_area_full,’ the cell size is approximately 0.12 meters, and the file size
about 6.5 Mb (25% the size of the full resolution subset image).

Close the image windows and the Algorithm dialog
1 Close the image windows.

2 On the Algorithm  dialog, click the Close  button.

Only the ER Mapper main menu is now open on the screen.

• Define an exact area of interest using geographic coordinates

• Save the image as a new UDF dataset

• Resample the resolution (cell size) of a dataset

• Save the image as a TIFF format graphics file

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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ArcView® GIS
Users

This chapter explains how to use the free ER Mapper Imagery Extension for 
ESRI’s ArcView® GIS software. It also explains how to obtain and install the 
extension, and the additional imaging capabilities ArcView users can gain by u
the extension in conjunction with ER Mapper.

Plugins are available for other applications. This chapter is included as an exa
of how you can use them.

Note: You must have a licensed copy of ArcView GIS version 3.1 or greater to install
run the ER Mapper Imagery Extension.

As imagery data sources become more important for GIS applications, the ne
efficiently process, enhance and display large image files also becomes more
important. Earth Resource Mapping (developers of ER Mapper) provides a fre
extension (or “plug-in”) that lets ArcView GIS users directly display ER Mappe
imagery and algorithms. With the ER Mapper Imagery Extension, ArcView GIS
users are no longer restricted by limited image handling capabilities. In additio
you can experience the full power of ER Mapper algorithms from within ArcVie
GIS, and give your vector GIS data real world meaning by presenting it over im
backdrops.
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How to obtain the ER Mapper Imagery Extension
You can obtain the free ER Mapper Imagery Extension from two sources:

• The ER Mapper installation CD-ROM–The extension can be installed as a 
separate component from the ER Mapper installation CD-ROM. (It is recommen
that you also install ER Mapper to gain access to a wide variety of sample dat
test drive the software in free evaluation mode to see what it can do for you.)

• The ER Mapper web site–You can download the latest version of the extensio
from the ER Mapper web site at www.ermapper.com. Navigate to the “free 
software” area and download the ArcView GIS plug-in.

Hands-on exercises
These exercises show you how to use the ER Mapper Imagery extension for 
ArcView GIS.

• Enable the ER Mapper Imagery Extension after starting ArcView GIS

• Display an ER Mapper algorithm file (.alg) as an Image Data Source

• Display and ECW compressed image (.ecw) as an Image Data Source

1: Using the ER Mapper extension

Start ArcView GIS
1 Start the ArcView GIS software on your system.

2 If the Welcome to ArcView GIS dialog appears, click Cancel .

3 Click the Maximize   button in the upper-right corner of the ArcView GIS 
application window (if it is not already maximized)

ArcView GIS expands to fill your desktop.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ArcView GIS using the ER Mapper Imagery Extension:

Before you 
begin...

Before beginning these exercises, you must have installed ArcView GIS versio
3.1 or higher and the ER Mapper extension for ArcView on your system. .

Objectives Learn to enable the ER Mapper extension for ArcView and display ER Mappe
imagery (.ers) files and algorithm (.alg) files.
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Load the ER Mapper extension
1 From the File  menu, select Extensions... .

2 On the Extensions  dialog, click on the box next to ‘ECW v2.0 and ER 
Mapper Imagery’ (a check mark should appear).

3 Turn on the ‘Make Default’ option, then click OK.

The ER Mapper Imagery Extension for ArcView GIS loads. You can now displ
ER Mapper algorithm and imagery files. Since you selected ‘Make Default,’ th
extension will load automatically each time you start ArcView GIS.

Open an ER Mapper algorithm (.alg) file
ER Mapper algorithms let you define a “view” into your data that you can save
reload, and modify at any time. By using the ER Mapper Imagery Extension, y
can display ER Mapper algorithms just like any other image data source.

1 If the Project window is not open, select File  -> New Project .

2 On the Project window, click New to open a View window. (It should be titled 
‘View1’.)

3 On the Add Theme  dialog, select ‘Image Data Source’ from the ‘Data 
Source Types’ list. (ER Mapper imagery and algorithms are always image 
data sources in ArcView GIS.)

4 Double-click on the folder where ER Mapper is installed. Then open the 
directory named ‘functions_and_features\airphoto_tutorial.’

5 Double-click on your ‘airphoto_mosaic.alg’ algorithm to open it.

6 Click the check box next to the theme to turn it on.

turn on ER Mapper
extension

load extension
on startup
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ArcView GIS displays the unbalanced mosaic of five orthorectified color airpho
of the San Diego, California area that you created in a previous exercise.

7 Click the Zoom In   tool, then drag a box over the central part of the 
mosaic image to zoom into it.

8 Click the Pan  tool, then drag the image to view adjacent areas.

This example shows how you can access the power of ER Mapper algorithms
apply complex image enhancements and display them directly with ArcView G

Add a second view to display the ECW compressed image

1 Click the Minimize   button on the ‘View1’ window to minimize it (or 
close it if desired).

2 On the Project window, click New to open a new View window. (It should be 
titled ‘View2’.)

3 Click the Add Theme   button (or select View > Add Theme ). 

The files in the ‘functions_and_features\airphoto_tutorial’ directory should be 
displayed.

4 Double-click on the file ‘airphoto_mosaic_compressed.ecw.’

5 In the ‘View2’ window turn on the new theme.

ArcView GIS displays the compressed balanced image mosaic that you create
previous exercise. If you compare it to the algorithm you loaded earlier, you ca
how the balancing has enhanced the image. 

An advantage of using an ECW file over an algorithm is that you only require 
file. The algorithm requires the algorithm file itself and the data and header file
each individual image in the mosaic. 

6 Enlarge the ‘View2’ window to make the image larger.

7 Zoom in and pan to different parts of the image using the Zoom In   and 

Pan  tools.

Zoom, pan and measure the image

1 Click the Zoom In   tool, then drag a box over the central part of the 
SPOT image to zoom into it.

2 Click the Pan  tool, then drag the image to view adjacent areas.
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3 Click the Measure   tool, then drag a line to view distances across an 
area.

The line length appears in the lower-left corner of the ArcView GIS dialog.

4 Move the mouse pointer around inside the image. 

Geographic coordinates appear in the upper-right area indicating that the ima
georeferenced. (In this case to the UTM projection, so units are meters of Eas
and Northings.)
ER Mapper Airphoto Mosaic Tutorial 155



Chapter 10 ArcView® GIS Users ● 1: Using the ER Mapper extension

 in 
Close ArcView GIS
1 If desired, save your views as an ArcView project using File > Save Project 

As....

2 Close ArcView GIS by clicking the Close   button on the application 
window or selecting File -> Exit .

• Enable the ER Mapper Imagery Extension after starting ArcView GIS

• Display an ER Mapper algorithm file (.alg) as an Image Data Source

• Display an ECW compressed image file (.ecw) as an Image Data Source

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ArcView GIS using the ER Mapper Imagery Extension:
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Windows®

applications (OLE)
This chapter explains how you can use your office software’s OLE capabilities
easily display and manipulate large images inside Windows applications (with
having to save the image as part of the file). 

Note: To use the OLE capabilities described here, make sure you first install ER Vie
from the ER Mapper installation CD-ROM or download it from the ER Mapper
website at www.ermapper.com.

About ER Viewer
ER Viewer is a free, easy to use image viewing application featuring interactiv
roaming and zooming of very large image files. In this example we use it as a
OLE server application to let you view images inside other Windows applicatio
ER Viewer offers unequalled stability and supports a wide range of image form
including: 

• Universal Data Format (UDF) images

• ER Mapper compressed and uncompressed images
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• TIFF and GeoTIFF images

• Windows BMP images

• SPOTView images

• ESRI BIL (ARC/INFO and ArcView) images

• ER Mapper algorithms

What is OLE?
Many Windows applications support OLE–Object Linking and Embedding. OLE is 
a program-integration technology developed by Microsoft that lets you easily s
information between programs. This capability allows you to insert an object (s
as an image) into any OLE-enabled application. Most office applications runni
under Microsoft Windows support OLE. 

With a linked object, information is created in one file (the source file) and inserted 
into another file (the destination file) while maintaining a connection or “link” 
between the two files. When you save the destination file (such as a word 
processing document), you save only the link to the source file and do not em
the image as part of the document. 

For example, several different documents can display the same image, all via
to the single source image file. If the source image file is modified, the linked 
image objects in the destination files are also automatically updated to reflect 
changes.

image
object

spreadsheet
document

image
object

word processing
document

image
object

presentation
document

Image file
(source file)
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Sharing image files using OLE
In addition to letting you view images, ER Viewer also acts as an OLE server 
application to let you view images inside your favorite Windows applications. 
Using ER Viewer’s OLE capabilities provides many advantages for sharing lar
image files throughout your enterprise, including:

• You can display image files much larger than the application itself is capable 
displaying (for example a 500MB airphoto) since ER Viewer performs the 
processing (not the application where the image is displayed)

• Much faster display of large image files in documents, since ER Viewer perfor
the processing (not the application where the image is displayed)

• Word processing documents, spreadsheets, presentations, and other applicatio
all share a single copy of the original imagery files

• Documents can display images in many additional image formats not supporte
the destination application, but that are supported by ER Viewer

• Images can be displayed in the application without having to permanently em
and save the image files as part of the document (so the documents remain sm
size)

• You can access the power of ER Mapper Algorithms to apply complex proces
enhancements that create beautiful images interactively without changing the
original image files

Hands-on exercises
These exercises show you how to insert an image into another Windows applic
as a linked OLE object using ER Viewer as the source application.

• Insert an image as a linked OLE object into another Windows application

• Edit the image object within the application using the ER Viewer toolbar

• Copy and paste an OLE image form one area to another

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in OLE-enabled Windows applications:

Before you 
begin...

Before beginning these exercises, you must have installed ER Viewer on your
system.
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1: Using OLE to display images

With Object Linking and Embedding (OLE), you can use ER Viewer as a powe
image viewing engine to display and edit large image files directly inside your 
Windows applications. This allows you to display images in many formats that
cannot be read by the application itself, and also makes the document files m
smaller because only a link to the image file is saved with the document.

The following example uses Microsoft Word as the example OLE-enabled 
application. You can use any other OLE-enabled word processing application 
desired (WordPerfect, Framemaker, and so on).

Start Microsoft Word (or other OLE-enabled word processor)
1 Start up the Word application on your system (or another OLE-enabled 

word processor).

2 Type the text San Diego Airphoto Mosaic Unbalanced as the first 
line of your document, then press Enter  to create a new line.

Open the Windows Explorer
1 Open the Windows Explorer application (select Start > Programs > 

Windows Explorer ).

2 Open the ER Mapper installation directory. Then open the directory 
‘examples\functions_and_features\airphoto_tutorial’

3 Move the Word application window and the Explorer window side by side 
(resize them if needed).

Drag an algorithm image file into the Word document
1 Drag the file ‘airphoto_mosaic.alg’ from the Explorer window and drop it into 

the Word document window.

After a short time, the image file displays in your document.

2 In the word processor, click once on the image to select it, then drag the 
lower-right corner handle to make it much larger.

The image redisplays at the larger size. This is the image mosaic you created
previous exercise.

Objectives Learn how to use ER Viewer as an OLE server to display and edit large image
files within OLE-enabled Windows applications.
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Zoom and roam using the ER Viewer toolbar
1 In Word, double-click on the image.

The word processor’s native toolbar changes to display the ER Viewer zoom a
roam tools. When you double-click on a linked object, the object’s server 
application (ER Viewer) is temporarily enabled inside the container application 
(the word processor) so you can edit the object.

2 Click the ZoomBox Tool   button, then drag a box to enclose the area of 
white buildings in the lower central portion of the image.

3 ER Viewer zooms in to display the area you defined with your box. 

4 Click the Hand Tool   button, then drag the image.

5 ER Viewer roams (or pans) to display the adjacent area of the image.

Return to the Word application
1 In the word processing document, click outside the image area.

The usual word processor toolbar and interface returns, and the image is upda
the new extents you defined.

Insert the ECW compressed image into the document
1 Press Enter twice to create two new lines below the image, then type the 

text San Diego Airphoto Mosaic Balanced and Compressed .

2 In the Explorer window, open the ER Mapper home directory, then open the 
directory ’examples\functions_and_features\airphoto_tutorial’.

3 Drag the file ‘airphoto_mosaic_compressed.ecw’ from the Explorer window 
and drop it into the word processing document window.

After a short time, the image file displays in your document.

4 Click once on the image to select it, then drag the lower-right corner handle 
to make it larger.

This is the compressed image mosaic you created earlier. When compared to
already loaded algorithm, it demonstrates how the balancing has enhanced th
image.

Tip: Most OLE-enabled applications also let you insert a linked OLE object into a 
document using a menu command (as an alternative to the drag and drop me
shown in the previous example).
ER Mapper Airphoto Mosaic Tutorial 161



Chapter 11 Windows® applications (OLE) ● 1: Using OLE to display images

ge 
 show 

 

 in 
Zoom into and center the compressed image
1 Double-click on the inserted image to display the ER Viewer toolbar.

2 Use the Zoom Tool   to zoom in on the central portion of the image, 

then use the Hand Tool   to drag the image and center it.

3 When finished, click outside the image to return to the word processing 
application.

Copy and paste the compressed image
1 Click once on the compressed image to select it.

2 Press Ctrl+C (or select Edit > Copy ) to copy it.

3 Press Enter twice to create two new paragraphs in your document.

4 Press Ctrl+V (or select Edit > Paste ) to paste the image into the new 
location.

It is sometimes useful to copy and paste OLE images from one part of your 
document to another. For example, you might insert an airphoto covering a lar
area, then copy and paste it to different parts of the document and zoom in to
different areas of interest.

(Optional) Save your word processing document.
1 Save your document, then close the application.

Note: You can display very large image files inside a document very quickly without 
having to embed the image files. (That is, images are not saved as part of the
document, only the link to them is saved.)

• Insert an image as a linked OLE object into another Windows application

• Edit the image object within the application using the ER Viewer toolbar

• Copy and paste an OLE image from one area to another

What you 
learned

After completing these exercises, you know how to perform the following tasks
OLE-enabled Windows applications:
162 ER Mapper Airphoto Mosaic Tutorial



re 
rnet 

ly in 
hich 

 

12

Image Web
Servers

Once you have created your airphoto mosaic, you need to consider how you a
going to use them, and how to make them available for others to use. The Inte
has become a popular way of distributing data. However, the large sizes of 
airphotos and slow network connections have precluded using the internet to 
distribute them. Traditionally, vendors have made ‘thumbnail” images, general
JPEG format, available on a Web Site. Users could then order the full images w
would be sent to them on a CD or other suitable medium. The diagram below
illustrates this:
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ER Mapper Image Web Server
The ER Mapper Image Web Server has changed the way images are distribut
You can now make your large airphoto mosaics available for download over th
Internet or company intranet. The combination of ECW v2 compression 
technology and the ECWP data transfer protocol has made this possible.

Server side
The Image Web Server is available as an add-on to the Microsoft IIS (Internet
Information Server). For small numbers of clients (less than 10) or evaluation 
purposes, you could use the Microsoft PWS (Personal Web Server). The follo
diagram shows the server architecture:

After installing the IIS or PWS, you can then add the Image Web Server. As w
any other web server you would have to define a virtual directory for the image
storage areas. You would then copy your ECW compressed images into the s
directory.

The Image Web Server also downloads controls to the client when requested b
client.

For a client application to access an image stored in the Image Web Server it 
specify the URL of the image. The URL must include the ECW protocol (ecwp
and the address of the Image Web Server. A typical URL is as follows:

 ecwp://earth.ermapper.com/images/hugeimage.ecw 

This is embedded in the HTML string. The IIS uses this to detect which incom
packets are destined for the Image Web Server, and directs them there.

IIS/PWS

Iimage
Web
Server

Network

Large
Image
Files

Client
software

ECW
compression
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Client side
The ECW compressed image data is in the form of blocks, which the Image W
Server can send separately as required.

When a client, in the form of an Internet Explorer or Netscape browser, access
Image Web Server page it needs to have valid control files installed. These co
enable the client to decompress, read, and display ECW compressed images
Image Web Server can download these to the client when requested. .

The following diagram illustrates the interactions between the client and the Im
Web Server.

When the client application accesses the image via the URL, it sends a reque
the Image Web Server for the information contained in the image header.

Using this information, the browser can use mouse and key entries to interact
request the control for a specific view of the image. On receiving this request,
control checks which image blocks are required, and requests the Image Web
Server to send those that it has not already cached. It then refreshes the displa
the new information. In this way the user can roam over and zoom into the ima
real time. Only the portion of the image actually being viewed is decompresse
This minimizes the network bandwidth and memory requirements for the client
with significant gains in performance.
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The control caches all the blocks that it receives and will not access the server
the required blocks are already cached. If there is insufficient room to cache n
blocks, it will flush the least recently used from the cache.

To access the server from within applications other than the Internet Explorer 
Netscape browsers, you would first have to download the applicable free plug
from the ER Mapper web site. You can then open the image in that application
specifying its URL, just as you would if you were using a browser. In the case
Microsoft Office applications, you must have the free ER Viewer program insta
on your PC. You can then use Windows OLE (Object Linking and Embedding)
insert the images into your Office document. As with the browsers, the plug-in
enables you to roam and zoom interactively with extremely efficient usage of t
client PC's resources.

Hands-on exercises
These exercises show you how to open an image served over the Internet via
Image Web Server. We will access the public www.earthetc.com Image Web S
to get the image.

• Open an image in ER Mapper by specifying its URL

• Open an image in ArcView by specifying its URLI

1: Open an image in ER Mapper

Load the image into an algorithm

1 Click on the Standard  toolbar Open   button to display the Open  dialog.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in OLE-enabled Windows applications:

Before you 
begin...

Before beginning these exercises, you must have installed ER Viewer and the
ArcView plugin on your system. Your PC must also be able to access the Inter

Objectives Learn how to open an image served from an Image Web Server in ER Mappe
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2 Enter ‘ecwp://www.earthetc.com/images/usa/SanDiego3i.ecw ’ 
in the Open  dialog Open:  field

This is the URL for the ‘SanDiego3i.ecw’ image at the ER Mapper public Imag
Web Server site. The Enhanced Compression Wavelet Protocol (ecwp) is use
compress, transfer and decompress the image.

3 Click OK on the Open  dialog.

If your PC has access to the Internet, the image window will display the 
compressed ‘spotcalif.ecw’ image. You will notice that the imagery that we ha
used in previous exercises is a subset of this much larger image.
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4 Re-size the window as required and use the ZoomBox   tool to zoom 
into the same part of the image that we have previously been using.

ER Mapper will request the server for the image blocks pertinent to your view 
display the zoomed image. The server only sends the blocks required for the 

Zoom into this part
of the image

Zoom into this part
of the image
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Note: If the image appears blurred, try clicking on the Refresh  button. With slow

network links ER Mapper might display the image before it is fully downloaded

Clicking the Refresh  button forces ER Mapper to redisplay the image usin

information cached in the PC.

5 Click on the Edit Algorithm   button to open the Algorithm  window.

You should notice that the image has been loaded into Red Green and Blue la
in the algorithm. You can now process the displayed image using the process
diagram buttons.

Saving the image as an algorithm 
1 From the File menu, select Save.

The Save As...  dialog box allows you to save your image view in a number of 
formats. If you do not want to save the actual image data, you can save the vie
any enhancements by saving the algorithm.

2 In the Save As  dialog select ‘ER Mapper Algorithm’ from the Files of type  
list.

3 From the Directories  menu, select the path ending with the text \examples . 
(The portion of the path name preceding it is specific to your site.)

4 Double-click on the directory named ‘functions_and_features’ and then 
‘airphoto_tutorial’ to open it. 

5 In the Save As:  text field, click to place the cursor, then type the following 
name for the algorithm file:

Airphoto_mosaic_balanced_url

6 Click the Apply button to save the algorithm and leave the dialog open.

The algorithm will be saved to disk.

7 Close the image window.

Reloading the algorithm

1 Click on the Open   button on the Standard  toolbar to display the Open  
dialog box.

2 Select your saved ‘Airphoto_mosaic_balanced_url.alg’ algorithm and click 
OK.
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ER Mapper will now display the image view from the www.earthEtc.com Imag
Web Server. If the view is not cached on the PC, it will request it over the Inter

Once again, you may have to click on the Refresh button  a number of times 

to get a clear image.

3 Close the image window.

Using the History file
ER Mapper keeps a list of the five most recently accessed URLs. If you want 
reload the image you can select it from this list instead have having to type it i
URL again.

1 Click on the Open   button on the Standard  toolbar to display the Open  
dialog box.

2 On the Open  dialog box, select the ECW URL History  menu.

This will display up to 5 most recently accessed URLs.

3 Select the required URL from the list and click OK.

ER Mapper will display the selected image. 

4 Close the Image and the Algorithm windows. 

2: Open an image in ArcView®GIS

Open a URL file
The ER Mapper extension enables you to open an ECW compressed image, s
via an ER Mapper Image Web Server, inside arcview by specifying its URL. Y
can then zoom into and roam over this image in real time. The Image Web Se
sends the compressed image blocks as they are requested. 

Objectives Learn how to open an image served from an Image Web Server in 
ArcView® GIS.
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The extension includes the facility to store image URLs in a ‘Favorites’ list so 
they can easily be accessed in later ArcView® sessions. You can also select U
from a ‘History’ list that displays the last 20 URLs requested.

1 Open the ArcView application.

2 On the Project window, click New to open a new View window. (It should be 
titled ‘View1’.)

3 Click the Add ECW Image Theme from an Image Web Server URL   
button (or select View > Add URL Theme ). 

This should open the Image Theme URL  dialog box.

4 Enter the following URL in the URL:  field.

ecwp://www.earthetc.com/images/usa/SanDiego3i.ecw

This URL will access the SanDiego3i.ecw compressed image file at the Earth
Resource Mapping www.earthetc.com web site. The protocol used is ECWP 
(Enhanced Compression Wavelet Protocol).

5 Click on the OK button.

The image will be loaded as theme via the Internet. If you have a slow connec
to the Internet this step could take a few minutes. If your PC is not able to acc
the www.earthetc.com web site, it will display an error message.

6 In the ‘View1’ window turn on the ‘Sandiago3i.url’ theme.
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ArcView GIS displays the San Diego airphoto mosaic image. 

7 In the ‘View1’ window, select the ‘Sandiego3i.URL’ theme and then select 
Edit > Delete Themes  to remove the theme. Answer Yes to the Delete 
Themes  query.

8 Click the Add ECW Image Theme   button (or select View > Add URL 
Theme ) to reopen the Image Theme URL  dialog box. 

The URL: field should now be blank.

9 From the History:  list select the ‘ecwp://www/earthetc.com/images/usa/
Sandiago3i.ecw’ entry.

The History:  list contains the last 20 URLs entered. This saves you from havin
type in the full URL to re-open a recently accessed image.

The URL:  field should now contain the URL that you selected from the History:  
list. If you were to click on the OK button, it would re-load the image as a theme 
the ‘View1’ window.

Turn on the theme
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10 Click on the Add to Favorites  button to open the Add to Favorites dialog 
box.

This box allows you to select a directory and file name to store URLs that you
likely to access again. The file names all have a .url extension.

You should note that there is already a ‘sandiego3i.url’ entry in the 
‘arcview\averm\urls’ directory. The ER Mapper extension automatically create
these files in the default directory whenever you access a URL. The Add to 
Favorites  facility is really only required if you want to save the URL to anothe
directory and/or under another name.

11 Click on the OK button to return to the Image Theme URL  dialog box. 

12 Click on the Open from Favorites  button.

This opens the Open From Favorites  dialog box

13 Select the ‘arcview\averm\urls’ directory if it is not already selected.

14 Select the ‘sandiego3i.url’ file that was automatically created by the 
ER Mapper extension.

15 Click on the OK button to return to the Image Theme URL dialog.

The URL: field should now contain the full URL .

16 Click on the OK button.

The image will be loaded as theme via the Internet. If you have a slow connec
to the Internet this step could take a few minutes. If your PC is not able to acc
the www.earthetc.com web site, it will display an error message. 

17 In the ‘View1’ window turn on the ‘Sandiego3i.url’ theme.

Zoom, pan and measure the image

1 Click the Zoom In   tool, then drag a box over the central part of the 
image to zoom into it.
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2 Click on the Refresh View   button to improve the image resolution.

Tip: If you are connected to the Internet via a slow link, you may have to click on th
Refresh View button a number of times to get the best resolution. This is beca
ArcView® may display the image before it is fully downloaded from the server
The Refresh View  button reloads the image with all new information that has 
been cached on the PC.

3 Click the Pan  tool, then drag the image to view adjacent areas.

4 Click on the Refresh View   button to improve the image resolution.

5 Click the Measure   tool, then drag a line to view distances across an 
area.

The line length appears in the lower-left corner of the ArcView GIS dialog.
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Close ArcView GIS
1 If desired, save your views as an ArcView project using File > Save Project 

As....

2 Close ArcView GIS by clicking the Close   button on the application 
window or selecting File > Exit .

• Display an ECW compressed image in ER Mapper via its URL

• Display an ER Mapper URL file (.ecw) in ArcView as an Image Data Source.

What you 
learned...

After completing these exercises, you know how to perform the following task
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